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1. Introduction 

This section outlines the purpose and scope of the for the Archive Project. 

1.1 Purpose 

The purpose of this document is to create SOPs to test the functions in the Archive that the users have 

requested in the requirements document.  

Please note that the version you are reading is a draft due to the daily updating. This is a unique 

document, which has not been attempted before at ABC Inc. Every SOP contains instructions to the 

reader/user on using the various features as well as information on the visual result which is contained in 

separate documents (Appendix A, Appendix B etc.) due to the size of the documents. The hotlinks to the 

screen images from this document will be updated only in the final document. 

1.2 Expected Results 

In the list of SOPs there is a column, which provides information on the expected result for each test 

case.  
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Due to the size of this document, separate files (Appendix A, Appendix B, etc.) have been created which 

contains the screen images of the expected results. This document (containing the SOPs) should be read 

in conjunction with the Appendices. 
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2. Grouping of SOPs 

The SOPs will be grouped as follows: 

o SEC = Security – Logging in on to OnDemand for various levels of users AND logging off 

o FLD = Folder access 

o DOC = Document/Report Access 

o ANN = Annotations - Text, Graphical 

o SRC = Searches – Retrievability of different reports based on the following criteria 

- CRS Account Number 

- Cheque Serial Number or range of Serial 

Numbers 

- Date or Date Range 

- Report Description 

- Company Name 

 

 Each search  

 field or a   

 combination of  

 several fields 

 

o TBB = Tool Bar Buttons 

o MBB = Menu Bar Buttons 
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3. SOPs for OnDemand  

GROUPING LEGEND:   SEC=Security        FLD=Folder Access DOC=Document/Report Access ANN=Annotations  SRC=Searches    TBB=Tool Bar 
Buttons MBB=Menu Bar Buttons DAF=Functions specific to DAF   

ACCESS LEVEL LEGEND:  ABCCRSSupervisors  = Manager, Team Leader, Production Control Officer 
   ABCCRSOfficers  = Officers (Accounts) 
   ABCCRSAuditors  = Audit Officers 
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3.1 End User Logon and Logoff (See Appendix A for screen images) 

3.1.1 Logon 

SEC CB001  S Logging on to OnDemand P Ability of 
authorized 
users to 
logon to 
OnDemand 

1. Double-click the left mouse button on the 
OnDemand icon (or follow any instructions 
provided to you separately) 

2. Log on to OnDemand by doing the 
following: 

(a) Enter the User ID (for ABC#CRSSUP 
Group) 

(b) Enter your password 

(c) Select OK. 

 

Screen No.A1, A2, A3, A5– 
Appendix A 

  

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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SEC CB002  O Logging on to OnDemand P Ability of 
authorized 
users to 
logon to 
OnDemand 

1. Double-click the left mouse button on the 
OnDemand icon (or follow any instructions 
provided to you separately) 

2. Log on to OnDemand by doing the 
following: 

(a) Enter the User ID (for ABC#CRSSUP 
Group) 

(b) Enter your password 

(c) Select OK. 

 

Screen No.A1, A2, A3, A5– 
Appendix A 

  

SEC CB003  A Logging on to OnDemand P Ability of 
authorized 
users to 
logon to 
OnDemand 

1. Double-click the left mouse button on the 
OnDemand icon (or follow any instructions 
provided to you separately) 

2. Log on to OnDemand by doing the 
following: 

(a) Enter the User ID (for 
ABC#CRSAUDTR Group) 

(b) Enter your password 

(c) Select OK. 

 

Screen No.A1, A2, A3, A5– 
Appendix A 

  

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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3.1.2 LogOff / Exit OnDemand 

SEC CB004  S Logoff From File Menu   1.     

SEC CB005  O Logoff From File Menu   1.     

SEC CB006  A Logoff From File Menu   1.     

SEC CB007  S Exit OnDemand From File Menu   1.     

SEC CB008  O Exit OnDemand From File Menu   1.     

SEC CB009  A Exit OnDemand From File Menu   1.     

3.2 End User Functional Testing – End User Security  

SEC CB0010  

A
B

C
C

R
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S
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Verifying user ID’s individually P To ensure 
that users 
belonging to 
CRS Dept. 
can log on 
to 
OnDemand 
without any 
encumbran
ce 

 

 

Review and compare with report or printout 
of all user ID’s and permissions from 
OnDemand 

Information for each user is 
correctly set up 

(Review paper documentation) 
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SEC CB0011  
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Verifying user ID’s individually P To ensure 
that users 
belonging to 
CRS Dept. 
can log on 
to 
OnDemand 
without any 
encumbran
ce 

 

 

Review and compare with report or printout 
of all user ID’s and permissions from 
OnDemand 

Information for each user is 
correctly set up 

(Review paper documentation) 

 

  

SEC CB0012  
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Verifying user ID’s individually P To ensure 
that users 
belonging to 
CRS Dept. 
can log on 
to 
OnDemand 
without any 
encumbran
ce 

 

 

Review and compare with report or printout 
of all user ID’s and permissions from 
OnDemand 

Information for each user is 
correctly set up 

(Review paper documentation) 

 

  

SEC CB0013  
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End User 
permissions for 
each user 
group: 

CRS –
Supervisors 

 

P To test End 
User 
permissions 
for 
Supervisor 
group 

1. Log on to OnDemand  

2. Enter the User ID 

3. Enter your password 

4. Select OK 

Screen No.A5 – Appendix A   

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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SEC CB0014  

A
B

C
C

R
S
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End User 
permissions for 
each user 
group 

Officers P To test End 
User 
permissions 
for Officers 
user group 

1. Log on to OnDemand  

2. Enter the User ID  

3. Enter your password 

4. Select OK 

Screen No.A5 – Appendix A   

SEC CB0015  

A
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End User 
permissions for 
each user 
group: 

Auditors 

 

P To test End 
User 
permissions 
for 
Audigtors 
user group 

1. Log on to OnDemand  

2. Enter the User ID  

3. Enter your password 

4. Select OK 

Screen No.A5 – Appendix A   

SEC CB0016  
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ff
 Test End User 

permissions for 
user groups not 
allowed 

 N To ensure 
that 
unauthorize
d users are 
not able to 
access 
OnDemand 

1. Log on to OnDemand  

2. Enter any User ID  

3. Enter any password 

4. Select OK 

Screen No.A5 – Appendix A 

 

  

SEC CB0017  

A
B

C
A

cc
ou

nt
in

gS
ta

ff
 

Test End User 
permissions for 
users repeated 
log-on 

 N To ensure 
that 
unauthorize
d users are 
not able to 
access 
OnDemand 

1. Log on to OnDemand  

2. Enter any User ID (for 
ABCAccountingStaff Group) 

3. Enter any password 

4. Select OK 

5. Repeat steps 2 to 4 with wrong ID and 
wrong PW 

Screen No.A4 – Appendix A 

 

  

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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3.2.1 Folder Access (Sample folders only – Other folders are included in the SOPs under different sections) 

3.2.1.1 Cheque Serial Number Folder 

FLD CB0018   Cheque Serial 
Number Folder  

Supervisors P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select Reports - Cheque Serial Number 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A7 – Appendix A   

FLD CB0019   Cheque Serial 
Number Folder  

Officers P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select Reports - Cheque Serial Number 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A7 – Appendix A   

FLD CB0020   Cheque Serial 
Number Folder  

Auditors P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports - Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A7 – Appendix A   
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3.2.1.2 Internal Accounts Balancing Folder 

FLD CB0021   Internal 
Accounts 
Balancing 
Folder  

Supervisors P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A8 – Appendix A   

FLD CB0022   Internal 
Accounts 
Balancing 
Folder  

Officers P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A8 – Appendix A   

FLD CB0023   Internal 
Accounts 
Balancing 
Folder  

Auditors P Verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen A6 & A8 – Appendix A   
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3.2.2 Documents/Reports Access 

3.2.2.1 Cheque Serial No. Folder 

DOC CB0024   Paid 
Items 
Report 
301 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 301 Paid Items and press 
Enter. 

Screen A9– Appendix A   

DOC CB0025   Paid 
Items 
Report 
301 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 301 Paid Items and press 
Enter. 

Screen A9– Appendix A   

DOC CB0026   Paid 
Items 
Report 
301 

Audi
tors 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 301 Paid Items and press 
Enter. 

Screen A9– Appendix A   

DOC CB0027   Paid 
Items 
Report 
301 

Sup Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0028   Paid 
Items 
Report 
301 

Offic
ers 

Print  P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0029   Paid 
Items 
Report 
301 

Audi
tor 

Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0030   Paid Sup Copy N Not be able 1. When the Report appears, select Edit. All the options are grayed out.   

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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Items 
Report 
301 

to copy the 
report 

 

DOC CB0031   Paid 
Items 
Report 
301 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0032   Paid 
Items 
Report 
301 

Audi
tors 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0033   Paid 
No 
Issue 
Report 
303 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 301 Paid Items and press 
Enter. 

Screen A10– Appendix A   

DOC CB0034   Paid 
No 
Issue 
Report 
303 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 303 Paid No Issue and 
press Enter. 

Screen A10– Appendix A   

DOC CB0035   Paid 
No 
Issue 
Report 
303 

Audi
tor 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 303 Paid No Issue and 
press Enter. 

Screen A10– Appendix A   

DOC CB0036   Paid 
No 
Issue 
Report 

Sup Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

file://///toadfp80/TSEQUEI$/Archiving/Testing/Completed%20Test%20Cases/From%20Cheryl%20Jan%2025/Testing_Jan_04_Appendix_A.doc
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Remarks 

303 

DOC CB0037   Paid 
No 
Issue 
Report 
303 

Offic
ers 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0038   Paid 
No 
Issue 
Report 
303 

Audi
tor 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0039   Paid 
No 
Issue 
Report 
303 

Sup Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0040   Paid 
No 
Issue 
Report 
303 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0041   Paid 
No 
Issue 
Report 
303 

Audi
tor 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0042   Stop 
Payme
nts 
Report 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 304 Stop Payment and 

Screen A11– Appendix A   
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304 press Enter. 

DOC CB0043   Stop 
Payme
nts 
Report 
304 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 304 Stop Payment and 
press Enter. 

Screen A11– Appendix A   

DOC CB0044   Stop 
Payme
nts 
Report 
304 

Audi
tor 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 304 Stop Payment and 
press Enter. 

Screen A11– Appendix A   

DOC CB0045   Stop 
Payme
nts 
Report 
304 

Sup Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0046   Stop 
Payme
nts 
Report 
304 

Offic
ers 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0047   Stop 
Payme
nts 
Report 
304 

Audi
tor 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0048   Stop 
Payme
nts 
Report 

Sup Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   
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304 

DOC CB0049   Stop 
Payme
nts 
Report 
304 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0050   Stop 
Payme
nts 
Report 
304 

Audi
tor 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

 

3.2.2.2 Internal Accounts Balancing Folder (Documents/Reports Access): 

DOC CB0051   Outsta
nding 
Issues 
Report 
305 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 305 Outstanding Issues 
and press Enter. 

Screen A12– Appendix A   

DOC CB0052   Outsta
nding 
Issues 
Report 
305 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 305 Outstanding Issues 
and press Enter. 

Screen A12– Appendix A   

DOC CB0053   Outsta
nding 
Issues 
Report 
305 

Audi
tor 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select 305 Outstanding Issues 
and press Enter. 

Screen A12– Appendix A   
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DOC CB0054   Outsta
nding 
Issues 
Report 
305 

Sup Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0055   Outsta
nding 
Issues 
Report 
305 

Offic
ers 

Print  P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0056   Outsta
nding 
Issues 
Report 
305 

Audi
tor 

Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0057   Outsta
nding 
Issues 
Report 
305 

Sup Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0058   Outsta
nding 
Issues 
Report 
305 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0059   Outsta
nding 
Issues 
Report 
305 

Audi
tor 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   
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DOC CB0060   File 
Maint. 
Regist
er 
Report 
3 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Report 3 Maintenance 
Report and press Enter. 

Screen A13– Appendix A   

DOC CB0061   File 
Maint. 
Regist
er 
Report 
3 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Report 3 Maintenance 
Report and press Enter. 

Screen A13– Appendix A   

DOC CB0062   File 
Maint. 
Regist
er 
Report 
3 

Audi
tor 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Report 3 Maintenance 
Report and press Enter. 

Screen A13– Appendix A   

DOC CB0063   File 
Maint. 
Regist
er 
Report 
3 

Sup Print P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0064   File 
Maint. 
Regist
er 
Report 
3 

Offic
cers 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   
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DOC CB0065   File 
Maint. 
Regist
er 
Report 
3 

Audi
tor 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0066   File 
Maint. 
Regist
er 
Report 
3 

Sup Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0067   File 
Maint. 
Regist
er 
Report 
3 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0068   File 
Maint. 
Regist
er 
Report 
3 

Audi
tor 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0069   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Sup Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Rpt 007 FRS Daily: 
Account Balance and press Enter. 

Screen A14– Appendix A   
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DOC CB0070   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Offic
ers 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Rpt 007 FRS Daily: 
Account Balance and press Enter. 

Screen A14– Appendix A   

DOC CB0071   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Audi
tor 

Access to the 
Report 

P Test with 
sample 
report 

1. After arriving at the screen that displays all 
the reports, under the “Report Description” 
column select Rpt 007 FRS Daily: 
Account Balance and press Enter. 

Screen A14– Appendix A   

DOC CB0072   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Sup Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0073   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Offic
ers 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   

DOC CB0074   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Audi
tor 

Print/Fax P Printing the 
Report 

1. When the Report appears, you can print 
the report by selecting the Print button or 
by selecting File and then Print. 

The Report will be printed   
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DOC CB0075   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Sup Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0076   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Offic
ers 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

DOC CB0077   FRS 
D.R:Ac
count 
Bal. 
Report 
7 

Audi
tor 

Copy N Not be able 
to copy the 
report 

1. When the Report appears, select Edit. 

 

All the options are grayed out.   

3.2.3 Annotations Permissions (Sample Reports) 

3.2.3.1 Cheque Serial Number Folder  

ANN CB0078   Paid 
Items 
Report 
301 

Sup Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Screen A15 – Appendix A   
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ANN CB0079   Paid 
Items 
Report 
301 

Offic
ers  

Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Screen A15 – Appendix A   

ANN CB0080   Paid 
Items 
Report
301 

Audit
or 

Add Notes N To ensure 
inability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Not able to add notes   

ANN CB0081   Paid 
Items 
Report
301 

Sup Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Screen A16 - Appendix A   

ANN CB0082   Paid 
Items 
Report 
301 

Offic
ers 

Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

Screen A16 - Appendix A   
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report 3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

ANN CB0083   Paid 
Items 
Report
301 

Audit
or 

Add Graphical 
Annotation 

N To ensure 
inability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Not able to add notes   

ANN CB0084   Paid 
Items 
Report
301 

Sup View Notes P To ensure 
ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB0085   Paid 
Items 
Report
301 

Offic
ers 

View Notes P To ensure 
ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB0086   Paid 
Items 
Report

Audit
or 

View Notes P Ability of 
user to view 
the notes 
made in the 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A17 - Appendix A   
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301 report 301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

ANN CB0087   Paid 
Items 
Report
301 

Sup View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB0088   Paid 
Items 
Report
301 

Offic
ers 

View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB0089   Paid 
Items 
Report
301 

Audit
or 

View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB0090   Paid 
Items 
Report
301 

Sup View User’s ID of 
Graphical 
Annotation (GA) 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screen  -- - 
Append A) 
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button 

4. From the options, select Stamp Property 
Sheet. 

ANN CB0091   Paid 
Items 
Report
301 

Offic
ers 

View User’s ID of 
Graphical 
Annotation (GA) 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screen  -- - 
Append A) 

  

ANN CB0092   Paid 
Items 
Report
301 

Audit
or 

View User’s ID of 
Graphical 
Annotation 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screen  -- - 
Append A) 

  

ANN CB0093   Paid 
Items 
Report

Sup Delete Notes P To ensure 
ability of 
Supervisor 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A18 - Appendix A   
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301 to delete 
the notes 
made in the 
report 

301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

ANN CB0094   Paid 
Items 
Report
301 

Offic
ers 

Delete Notes N To ensure 
the inability 
of Officers 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

Not be able to delete notes   

ANN CB0095   Paid 
Items 
Report
301 

Audit
or 

Delete Notes N To ensure 
the inability 
of Auditors 
to delete 
the notes 
made in the 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Not be able to delete notes   
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Remarks 

report the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

ANN CB0096   Paid 
Items 
Report
301 

Sup Delete Graphical 
Annotation 

P To ensure 
ability of 
Supervisor 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

3. Select Delete Box or Stamp, etc. 

4. Select Yes. 

The graphical annotation/s will be 
deleted. 

  

ANN CB0097   Paid 
Items 
Report
301 

Offic
ers 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Officers 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

 

Not be able to delete graphical 
annotation 

  

ANN CB0098   Paid 
Items 
Report
301 

Audit
or 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Auditors 
to delete 
the 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

Not be able to delete graphical 
annotation 
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graphical 
annotation 
made in the 
report 

2. Right click your mouse. 

 

ANN CB0099   Paid 
Items 
Report
301 

Sup Update Notes P To ensure 
ability of 
Supervisor 
to use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

4. Select any of the options you require. 

Screen A19 - Appendix A   

ANN CB00100   Paid 
Items 
Report
301 

Offic
ers 

Update Notes P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

4. Select any of the options you require. 

Screen A19 - Appendix A   

ANN CB00101   Paid 
Items 
Report
301 

Audit
or 

Update Notes N To ensure 
inability of 
Auditors to 
use the 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

The options to change the 
appearance of the note are 
grayed out. 

?  
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“Update” 
feature of 
notes made 
in the report 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

ANN CB00102   Paid 
Items 
Report
301 

Sup Update 
Graphical 
Annotation (GA) 

P To ensure 
ability of 
Supervisor 
to use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

Screen A20 - Appendix A   

ANN CB00103   Paid 
Items 
Report
301 

Offic
ers 

Update 
Graphical 
Annotation 

P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 

Screen A20 - Appendix A   
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Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

ANN CB00104   Paid 
Items 
Report
301 

Audit
or 

Update 
Graphical 
Annotation 

N To ensure 
the inability 
of Auditors 
to use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

The features will be grayed out.   

ANN CB00105   Paid 
Items 
Report
301 

Sup Copy Notes P To ensure 
ability of 
user to copy 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, select the 
contents of the note you want to copy and 
press the Copy button. 

Screen A21 - Appendix A 

The note will be copied to your 
clipboard. 

  

ANN CB00106   Paid 
Items 
Report
301 

Offic
ers 

Copy Notes N To ensure 
inability of 
Officers to 
copy notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

Not able to copy notes   
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3. Select View Notes 

4. From the Notes screen, you will see the 
Copy feature is grayed out. 

ANN CB00107   Paid 
Items 
Report
301 

Audit
or 

Copy Notes N To ensure 
inability of 
Auditors to 
copy notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, you will see the 
Copy feature is grayed out. 

Not able to copy notes   

ANN CB00108   Paid 
Items 
Report
301 

Sup Copy Graphical 
Annotation 

P To ensure 
ability of 
Supervisors 
to copy 
GA’s made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to copy ?  

ANN CB00109   Paid 
Items 
Report
301 

Offic
ers 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  
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ANN CB00110   Paid 
Items 
Report
301 

Audit
or 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  

ANN CB00111   Paid 
Items 
Report
301 

Sup Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

Screen A22 - Appendix A   

ANN CB00112   Paid 
Items 
Report
301 

Offic
ers 

Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 

Screen A22 - Appendix A   
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notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

ANN CB00113   Paid 
Items 
Report
301 

Audit
or 

Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

Screen A22 - Appendix A   

ANN CB00114   Paid 
Items 
Report
301 

Sup Print Graphical 
Annotation (GA) 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

No option to print ?  
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3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

ANN CB00115   Paid 
Items 
Report
301 

Offic
ers 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00116   Paid 
Items 
Report
301 

Audit
or 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00117   Paid 
Items 

Sup Sort Notes – 
Ascending 

P Ability to 
sort Notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

Screen A23 - Appendix A   
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Report
301 

in 
ascending 
order. 

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

ANN CB00118   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

Screen A23 - Appendix A   

ANN CB00119   Paid 
Items 
Report
301 

Audit
or 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

Screen A23 - Appendix A   
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5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

ANN CB00120   Paid 
Items 
Report
301 

Sup Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

Screen A23 - Appendix A   

ANN CB00121   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

Screen A23 - Appendix A   

ANN CB00122   Paid 
Items 
Report

Audit
or 

Sort Notes –
Descending 

P Ability to 
sort Notes 
in 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
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301 descending 
order. 

301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

ANN CB00123   Paid 
Items 
Report
301 

Sup Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 - Appendix A   

ANN CB00124   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A23 - Appendix A   
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4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

ANN CB00125   Paid 
Items 
Report
301 

Audit
or 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 - Appendix A   

ANN CB00126   Paid 
Items 
Report
301 

Sup Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00127   Paid 
Items 

Offic Sort Notes 1 – P Ability to 
sort Notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
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Report
301 

ers User ID 1 according to 
User ID  

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00128   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00129   Paid 
Items 
Report
301 

Sup Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

Screen A23 - Appendix A   
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5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00130   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00131   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00132   Paid 
Items 
Report
301 

Sup Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
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the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00133   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00134   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   
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ANN CB00135   Paid 
Items 
Report
301 

Sup Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00136   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00137   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A23 - Appendix A   
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4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00138   Paid 
Items 
Report
301 

Sup Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00139   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00140   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A23 - Appendix A   
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User ID  301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00141   Paid 
Items 
Report
301 

Sup Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 - Appendix A   

ANN CB00142   Paid 
Items 
Report
301 

Offic
ers 

Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
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screen, select User ID and press Sort. 

ANN CB00143   Paid 
Items 
Report
301 

Audit
or 

Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23- Appendix A   

 

ANN CB00144   Outsta
nding 
Issues
305 

Sup Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Screen A15 - Appendix A   

ANN CB00145   Outsta
nding 
Issues
305 

Offic
ers  

Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

Screen A15 - Appendix A   
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3. Select Add Notes 

ANN CB00146   Outsta
nding 
Issues
305 

Audit
or 

Add Notes N To ensure 
inability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Not able to add notes   

ANN CB00147   Outsta
nding 
Issues
305 

Sup Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Screen A16 - Appendix A   

ANN CB00148   Outsta
nding 
Issues
305 

Offic
ers 

Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Screen A16 - Appendix A   

ANN CB00149   Outsta
nding 
Issues
305 

Audit
or 

Add Graphical 
Annotation 

N To ensure 
ability of 
user to add 
graphical 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Not able to add notes   
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annotations 
on the 
report 

301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

ANN CB00150   Outsta
nding 
Issues
305 

Sup View Notes P To ensure 
ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB00151   Outsta
nding 
Issues
305 

Offic
ers 

View Notes P To ensure 
ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB00152   Outsta
nding 
Issues
305 

Audit
or 

View Notes P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   
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Remarks 

ANN CB00153   Outsta
nding 
Issues
305 

Sup View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB00154   Outsta
nding 
Issues
305 

Offic
ers 

View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB00155   Outsta
nding 
Issues
305 

Audit
or 

View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB00156   Outsta
nding 
Issues
305 

Sup View User’s ID of 
Graphical 
Annotation (GA) 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screen  -- - 
Append A) 

  

ANN CB00157   Outsta
nding 

Offic View User’s ID of 
Graphical 

P Ability to 
view the 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

In the Stamp Property Sheet 
screen you will see the User’s ID 
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Remarks 

Issues
305 

ers Annotation (GA) User’s ID 
who made 
the GA in 
the report 

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

in the gray box (see Screen  -- - 
Append A) 

ANN CB00158   Outsta
nding 
Issues
305 

Audit
or 

View User’s ID of 
Graphical 
Annotation 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screen  -- - 
Append A) 

  

ANN CB00159   Outsta
nding 
Issues
305 

Sup Delete Notes P To ensure 
ability of 
Supervisor 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A18 - Appendix A   
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Remarks 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

ANN CB00160   Outsta
nding 
Issues
305 

Offic
ers 

Delete Notes N To ensure 
the inability 
of Officers 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

Not be able to delete notes   

ANN CB00161   Outsta
nding 
Issues
305 

Audit
or 

Delete Notes N To ensure 
the inability 
of Auditors 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 

Not be able to delete notes   
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Remarks 

Delete. 

6. Select Yes. 

ANN CB00162   Outsta
nding 
Issues
305 

Sup Delete Graphical 
Annotation 

P To ensure 
ability of 
Supervisor 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

3. Select Delete Box or Stamp, etc. 

4. Select Yes. 

The graphical annotation/s will be 
deleted. 

  

ANN CB00163   Outsta
nding 
Issues
305 

Offic
ers 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Officers 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

 

Not be able to delete graphical 
annotation 

  

ANN CB00164   Outsta
nding 
Issues
305 

Audit
or 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Auditors 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

 

Not be able to delete graphical 
annotation 

  

ANN CB00165   Outsta
nding 

Sup Update Notes P To ensure 
ability of 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

Screen A19 - Appendix A   
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Remarks 

Issues
305 

Supervisor 
to use the 
“Update” 
feature of 
notes made 
in the report 

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

4. Select any of the options you require. 

ANN CB00166   Outsta
nding 
Issues
305 

Offic
ers 

Update Notes P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

4. Select any of the options you require. 

Screen A19 - Appendix A   

ANN CB00167   Outsta
nding 
Issues
305 

Audit
or 

Update Notes N To ensure 
inability of 
Auditors to 
use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

The options to change the 
appearance of the note are 
grayed out. 

?  
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ANN CB00168   Outsta
nding 
Issues
305 

Sup Update 
Graphical 
Annotation (GA) 

P To ensure 
ability of 
Supervisor 
to use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

Screen A20 - Appendix A   

ANN CB00169   Outsta
nding 
Issues
305 

Offic
ers 

Update 
Graphical 
Annotation 

P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

Screen A20 - Appendix A   

ANN CB00170   Outsta
nding 

Audit
or 

Update 
Graphical 

N To ensure 
the inability 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

The features will be grayed out.   
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Remarks 

Issues
305 

Annotation of Auditors 
to use the 
“Update” 
feature of 
GA made in 
the report 

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

ANN CB00171   Outsta
nding 
Issues
305 

Sup Copy Notes P To ensure 
ability of 
user to copy 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, select the 
contents of the note you want to copy and 
press the Copy button. 

Screen A21 - Appendix A 

The note will be copied to your 
clipboard. 

  

ANN CB00172   Outsta
nding 
Issues
305 

Offic
ers 

Copy Notes N To ensure 
inability of 
Officers to 
copy notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, you will see the 
Copy feature is grayed out. 

Not able to copy notes   

ANN CB00173   Outsta
nding 

Audit Copy Notes N To ensure 
inability of 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

Not able to copy notes   
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Remarks 

Issues
305 

or Auditors to 
copy notes 

the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, you will see the 
Copy feature is grayed out. 

ANN CB00174   Outsta
nding 
Issues
305 

Sup Copy Graphical 
Annotation 

P To ensure 
ability of 
Supervisors 
to copy 
GA’s made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to copy ?  

ANN CB00175   Outsta
nding 
Issues
305 

Offic
ers 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  

ANN CB00176   Outsta
nding 
Issues
305 

Audit
or 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  

ANN CB00177   Outsta
nding 
Issues

Sup Print Notes P To ensure 
ability of 
user to print 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A22 - Appendix A   
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Remarks 

305 the notes 
made in the 
report 

301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

ANN CB00178   Outsta
nding 
Issues
305 

Offic
ers 

Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

Screen A22 - Appendix A   

ANN CB00179   Outsta Audit Print Notes P To ensure 1. After arriving at the screen that displays all Screen A22 - Appendix A   
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nding 
Issues
305 

or ability of 
user to print 
the notes 
made in the 
report 

the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

ANN CB00180   Outsta
nding 
Issues
305 

Sup Print Graphical 
Annotation (GA) 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00181   Outsta
nding 
Issues
305 

Offic
ers 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

No option to print ?  
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made in the 
report 

301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

ANN CB00182   Outsta
nding 
Issues
305 

Audit
or 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00183   Outsta
nding 
Issues
305 

Sup Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

Screen A23 – Appendix A   
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5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

ANN CB00184   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

Screen A23 – Appendix A   

ANN CB00185   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

Screen A23 – Appendix A   

ANN CB00186   Outsta
nding 
Issues
305 

Sup Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Screen A23 – Appendix A   
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the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

ANN CB00187   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

Screen A23 – Appendix A   

ANN CB00188   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 

Screen A23 – Appendix A   
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Sort. 

ANN CB00189   Outsta
nding 
Issues
305 

Sup Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 – Appendix A   

ANN CB00190   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 – Appendix A   

ANN CB00191   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

Screen A23 – Appendix A   



SOPs for OnDemand 

Archive Project - SOPs for OnDemand – CRS Dept. , (Draft 5)  63 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

time 2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

ANN CB00192   Outsta
nding 
Issues
305 

Sup Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00193   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 

Screen A23 – Appendix A   
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screen, select User ID and press Sort. 

ANN CB00194   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00195   Outsta
nding 
Issues
305 

Sup Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00196   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Screen A23 – Appendix A   
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the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00197   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00198   Outsta
nding 
Issues
305 

Sup Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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ANN CB00199   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00200   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00201   Outsta
nding 
Issues
305 

Sup Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A23 – Appendix A   
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4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00202   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00203   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00204   Outsta
nding 
Issues
305 

Sup Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A23 – Appendix A   
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User ID  301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00205   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00206   Outsta
nding 
Issues
305 

Audit
or 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 

Screen A23 – Appendix A   
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screen, select User ID and press Sort. 

ANN CB00207   Outsta
nding 
Issues
305 

Sup Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00208   Outsta
nding 
Issues
305 

Offic
ers 

Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   

ANN CB00209   Outsta
nding 
Issues
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Audit
or 

Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Screen A23 – Appendix A   
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the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

 

3.2.3.2 Internal Accounts Balancing Folder (Annotations Permissions (Sample Reports) 

ANN CB00210   FRS:A
cc.Bal 
7 

Sup Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Screen A15 – Appendix A   

ANN CB00211   FRS:A
cc.Bal 
7 

Offic
ers  

Add Notes P To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select Add Notes 

Screen A15 – Appendix A   

ANN CB00212   FRS:A
cc.Bal 
7 

Audit
or 

Add Notes N To ensure 
ability of 
user to add 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Not able to add notes   
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the menu bar 

3. Select Add Notes 

ANN CB00213   FRS:A
cc.Bal 
7 

Sup Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Screen A16 - Appendix A   

ANN CB00214   FRS:A
cc.Bal 
7 

Offic
ers 

Add Graphical 
Annotation 

P To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Screen A16 - Appendix A   

ANN CB00215   FRS:A
cc.Bal 
7 

Audit
or 

Add Graphical 
Annotation 

N To ensure 
ability of 
user to add 
graphical 
annotations 
on the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select any of the options e.g. Pen, 
Highlighter, Box, etc. 

Not able to add notes   

ANN CB00216   FRS:A Sup View Notes P To ensure 1. After arriving at the screen that displays all Screen A17 - Appendix A   
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cc.Bal 
7 

ability of 
user to view 
the notes 
made in the 
report 

the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

ANN CB00217   FRS:A
cc.Bal 
7 

Offic
ers 

View Notes P To ensure 
ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB00218   FRS:A
cc.Bal 
7 

Audit
or 

View Notes P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A17 - Appendix A   

ANN CB00219   FRS:A
cc.Bal 
7 

Sup View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB00220   FRS:A
cc.Bal 

Offic
ers 

View Graphical 
Annotation 

P Ability of 
user to view 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 

When the report opens you 
should be able see the graphical 
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7 the notes 
made in the 
report 

the “Report Description” column select 
301 Paid Items and press Enter. 

 

annotations (stamps, highlights, 
etc.) 

ANN CB00221   FRS:A
cc.Bal 
7 

Audit
or 

View Graphical 
Annotation 

P Ability of 
user to view 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

 

When the report opens you 
should be able see the graphical 
annotations (stamps, highlights, 
etc.) 

  

ANN CB00222   FRS:A
cc.Bal 
7 

Sup View User’s ID of 
Graphical 
Annotation (GA) 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box (see Screens A24 
& A25 - Append A) 

  

ANN CB00223   FRS:A
cc.Bal 
7 

Offic
ers 

View User’s ID of 
Graphical 
Annotation (GA) 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box box (see Screens 
A24 & A25 - Append A) 
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4. From the options, select Stamp Property 
Sheet. 

ANN CB00224   FRS:A
cc.Bal 
7 

Audit
or 

View User’s ID of 
Graphical 
Annotation 

P Ability to 
view the 
User’s ID 
who made 
the GA in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

In the Stamp Property Sheet 
screen you will see the User’s ID 
in the gray box box (see Screens 
A24 & A25 - Append A) 

  

ANN CB00225   FRS:A
cc.Bal 
7 

Sup Delete Notes P To ensure 
ability of 
Supervisor 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

Screen A18 - Appendix A   

ANN CB00226   FRS:A
cc.Bal 
7 

Offic
ers 

Delete Notes N To ensure 
the inability 
of Officers 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Not be able to delete notes   
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Remarks 

to delete 
the notes 
made in the 
report 

301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

ANN CB00227   FRS:A
cc.Bal 
7 

Audit
or 

Delete Notes N To ensure 
the inability 
of Auditors 
to delete 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. Select Delete Notes. 

5. From the “Delete Notes” screen, select the 
note/s you want to delete and then press 
Delete. 

6. Select Yes. 

Not be able to delete notes   

ANN CB00228   FRS:A
cc.Bal 
7 

Sup Delete Graphical 
Annotation 

P To ensure 
ability of 
Supervisor 
to delete 
the 
graphical 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

The graphical annotation/s will be 
deleted. 
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annotation 
made in the 
report 

3. Select Delete Box or Stamp, etc. 

4. Select Yes. 

ANN CB00229   FRS:A
cc.Bal 
7 

Offic
ers 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Officers 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

 

Not be able to delete graphical 
annotation 

  

ANN CB00230   FRS:A
cc.Bal 
7 

Audit
or 

Delete Graphical 
Annotation 

N To ensure 
the inability 
of Auditors 
to delete 
the 
graphical 
annotation 
made in the 
report 

1. After arriving at the screen that displays 
the graphical annotation (see SOPs 73 & 
74), select the graphical annotation you 
want to delete 

2. Right click your mouse. 

 

Not be able to delete graphical 
annotation 

  

ANN CB00231   FRS:A
cc.Bal 
7 

Sup Update Notes P To ensure 
ability of 
Supervisor 
to use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

Screen A19 - Appendix A   
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4. Select any of the options you require. 

ANN CB00232   FRS:A
cc.Bal 
7 

Offic
ers 

Update Notes P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

4. Select any of the options you require. 

Screen A19 - Appendix A   

ANN CB00233   FRS:A
cc.Bal 
7 

Audit
or 

Update Notes N To ensure 
inability of 
Auditors to 
use the 
“Update” 
feature of 
notes made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, you will see an 

icon , which indicates that note/s is/are 
present in the report. 

3. Select that icon and click your right mouse 
button. 

The options to change the 
appearance of the note are 
grayed out. 

?  

ANN CB00234   FRS:A
cc.Bal 
7 

Sup Update 
Graphical 
Annotation (GA) 

P To ensure 
ability of 
Supervisor 
to use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 

Screen A20 - Appendix A   
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button 

4. From the options, select Stamp Property 
Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

ANN CB00235   FRS:A
cc.Bal 
7 

Offic
ers 

Update 
Graphical 
Annotation 

P To ensure 
ability of 
Officers to 
use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

5. Make the necessary changes you want to 
the appearance of the GA 

Screen A20 - Appendix A   

ANN CB00236   FRS:A
cc.Bal 
7 

Audit
or 

Update 
Graphical 
Annotation 

N To ensure 
the inability 
of Auditors 
to use the 
“Update” 
feature of 
GA made in 
the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

The features will be grayed out.   
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ANN CB00237   FRS:A
cc.Bal 
7 

Sup Copy Notes P To ensure 
ability of 
user to copy 
notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, select the 
contents of the note you want to copy and 
press the Copy button. 

Screen A21 - Appendix A 

The note will be copied to your 
clipboard. 

  

ANN CB00238   FRS:A
cc.Bal 
7 

Offic
ers 

Copy Notes N To ensure 
inability of 
Officers to 
copy notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, you will see the 
Copy feature is grayed out. 

Not able to copy notes   

ANN CB00239   FRS:A
cc.Bal 
7 

Audit
or 

Copy Notes N To ensure 
inability of 
Auditors to 
copy notes 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes 

4. From the Notes screen, you will see the 

Not able to copy notes   
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Copy feature is grayed out. 

ANN CB00240   FRS:A
cc.Bal 
7 

Sup Copy Graphical 
Annotation 

P To ensure 
ability of 
Supervisors 
to copy 
GA’s made 
in the report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to copy ?  

ANN CB00241   FRS:A
cc.Bal 
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Offic
ers 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  

ANN CB00242   FRS:A
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Audit
or 

Copy Graphical 
Annotation 

N  1.  Not able to copy graphical 
annotation 

?  

ANN CB00243   FRS:A
cc.Bal 
7 

Sup Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 

Screen A22 - Appendix A   
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All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

ANN CB00244   FRS:A
cc.Bal 
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Offic
ers 

Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 
to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

Screen A22 - Appendix A   

ANN CB00245   FRS:A
cc.Bal 
7 

Audit
or 

Print Notes P To ensure 
ability of 
user to print 
the notes 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, if there are several 
notes available, select the note you want 

Screen A22 - Appendix A   
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to print and press Print Note. If you want 
to print all the notes available, press Print 
All Notes. 

5. When you arrive at the “Print” screen, 
select the printer you want to use and 
press Print. 

ANN CB00246   FRS:A
cc.Bal 
7 

Sup Print Graphical 
Annotation (GA) 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00247   FRS:A
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Offic
ers 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  
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ANN CB00248   FRS:A
cc.Bal 
7 

Audit
or 

Print Graphical 
Annotation 

P To ensure 
ability of 
Users to 
print GA’s 
made in the 
report 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens you should be able 
see the graphical annotations (GA) e.g. 
stamps, highlights, etc. 

3. Select the GA and press your right mouse 
button 

4. From the options, select Stamp Property 
Sheet. 

No option to print ?  

ANN CB00249   FRS:A
cc.Bal 
7 

Sup Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

Screen A23 – Appendix A   

ANN CB00250   FRS:A
cc.Bal 
7 

Offic
ers 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

Screen A23 – Appendix A   
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3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

ANN CB00251   FRS:A
cc.Bal 
7 

Audit
or 

Sort Notes – 
Ascending 

P Ability to 
sort Notes 
in 
ascending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Ascending and press Sort. 

Screen A23 – Appendix A   

ANN CB00252   FRS:A
cc.Bal 
7 

Sup Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

Screen A23 – Appendix A   

ANN CB00253   FRS:A Offic Sort Notes – P Ability to 1. After arriving at the screen that displays all Screen A23 – Appendix A   
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cc.Bal 
7 

ers Descending sort Notes 
in 
descending 
order. 

the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

ANN CB00254   FRS:A
cc.Bal 
7 

Audit
or 

Sort Notes –
Descending 

P Ability to 
sort Notes 
in 
descending 
order. 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Descending and press 
Sort. 

Screen A23 – Appendix A   

ANN CB00255   FRS:A
cc.Bal 
7 

Sup Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

Screen A23 – Appendix A   
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3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

ANN CB00256   FRS:A
cc.Bal 
7 

Offic
ers 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 – Appendix A   
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Audit
or 

Sort Notes –Date P Ability to 
sort Notes 
according to 
creation 
date and 
time 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select Creation Date and Time 
and press Sort. 

Screen A23 – Appendix A   
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ANN CB00258   FRS:A
cc.Bal 
7 

Sup Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Offic
ers 

Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Audit
or 

Sort Notes 1 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A23 – Appendix A   
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4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00261   FRS:A
cc.Bal 
7 

Sup Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Offic
ers 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Audit
or 

Sort Notes 1 –
User ID 2 

P Ability to 
sort Notes 
according to 

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 

Screen A23 – Appendix A   
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User ID  301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00264   FRS:A
cc.Bal 
7 

Sup Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Offic
ers 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 

Screen A23 – Appendix A   
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screen, select User ID and press Sort. 

ANN CB00266   FRS:A
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Audit
or 

Sort Notes 2 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Sup Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Offic
ers 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 

Screen A23 – Appendix A   
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the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

ANN CB00269   FRS:A
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Audit
or 

Sort Notes 2 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Sup Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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ANN CB00271   FRS:A
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Offic
ers 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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or 

Sort Notes 3 – 
User ID 1 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Sup Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

Screen A23 – Appendix A   
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4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 
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Offic
ers 

Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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Sort Notes 3 –
User ID 2 

P Ability to 
sort Notes 
according to 
User ID  

1. After arriving at the screen that displays all 
the reports (see test case 0014), under 
the “Report Description” column select 
301 Paid Items and press Enter. 

2. When the report opens, select Notes from 
the menu bar 

3. Select View Notes from the menu bar. 

4. In the Notes screen, select Sort Notes. 

5. When you arrive at the “Sort Notes” 
screen, select User ID and press Sort. 

Screen A23 – Appendix A   
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3.3 Document Audit Facility (DAF) Folder (See Appendix B for screen images) 

3.3.1 Special Functions for the Three Groups 

DAF CB00276  S Accessing the 
DAF Folder 

Supervisors P Ability to 
access the 
DAF Folder 
and verify 
list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B1 & B2 - Appendix B   

DAF CB00277  S Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B3 - Appendix B   
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DAF CB00278  S Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B4 - Appendix B   

DAF CB00279  S Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B5 - Appendix A   
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DAF CB00280  O Accessing the 
DAF Folder 

Officers P Ability to 
access the 
DAF Folder 
and verify 
list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B1 & B2 - Appendix B   

DAF CB00281  O Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B3 - Appendix B   
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DAF CB00282  O Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B4 - Appendix B   

DAF CB00283  O Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B5 - Appendix A   
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DAF CB00284  A Accessing the 
DAF Folder 

Auditors P Ability to 
access the 
DAF Folder 
and verify 
list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B1 & B2 - Appendix B   

DAF CB00285  A Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B3 - Appendix B   
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DAF CB00286  A Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B4 - Appendix B   

DAF CB00287  A Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B5 - Appendix A   

DAF CB00288  S Paid 
Excep. 
302 

Sup Search by 
Report 

P Verify report 
is included 
in the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 

Screen B6 - Appendix A   
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Search. 

DAF CB00289  S Paid 
Excep. 
302 

Sup Change status to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pend. 

Screen B7 - Appendix A   

DAF CB00290  S Paid 
Excep. 
302 

Sup Change status to 
Actioned 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Action. 

Screen B8 - Appendix A   

DAF CB00291  O Paid 
Excep. 
302 

Offic
ers 

Change status to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pend. 

Screen B7 - Appendix A   

DAF CB00292  O Paid 
Excep. 
302 

Offic
ers 

Change status to 
Actioned 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Action. 

Screen B8 - Appendix A   

DAF CB00293  O Paid 
Excep. 
302 

Offic
ers 

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
302 reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 302 

Screen B9 - Appendix B   
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Paid Exception from the drop down 
options 

5. In the Report Status field select Pending 
from the drop-down options 

6. Press Search. 

DAF CB00294  O Paid 
Excep. 
302 

Offic
ers 

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
302 reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 302 
Paid Exception from the drop down 
options 

5. In the Report Status field select Actioned 
from the drop-down options 

6. Press Search. 

Screen B10 - Appendix B   

DAF CB00295  O Paid 
Excep. 
302 

Offic
ers 

Change status 
from Actioned to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pending. 

Screen B7 - Appendix A   

DAF CB00296  O Paid 
Excep. 
302 

Offic
ers 

Change status 
from Pending to 
Actioned 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Actioned. 

Screen B8 - Appendix A   
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DAF CB00297  A Paid 
Excep. 
302 

Audit
or 

Check Status P Ability to 
select a 
report and 
see the 
status 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 302 
Paid Exception from the drop down 
options 

5. Press Search. 

Screen B6 - Appendix A   

DAF CB00298  A Paid 
Excep. 
302 

Audit
or 

Change status to 
Pending 

N Inability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pend. 

Not able to change status   

DAF CB00299  A Paid 
Excep. 
302 

Audit
or 

Change status to 
Actioned 

N Inability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Action. 

Not able to change status   

DAF CB00300  A Paid 
Excep. 
302 

Audit
or 

Search by 
“Pending” 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pend. 

Screen B7 - Appendix A   

DAF CB00301  A Paid 
Excep. 
302 

Audit
or 

Search by 
“Actioned” 

P Ability to 
change the 
status of 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Action. 

Screen B8 - Appendix A   
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report to 
Actioned 

DAF CB00302  A Paid 
Excep. 
302 

Audit
or 

Change status 
from Actioned to 
Pending 

N Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Pending. 

Not be able to change the status   

DAF CB00303  A Paid 
Excep. 
302 

Audit
or 

Change status 
from  Pending to 
Actioned 

N Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select 302 Paid Exception 
and press Actioned. 

Not be able to change the status   

3.3.2 Company wide Document Audit Facility (DAF) Folder (See Appendix B for screen images) 

3.3.2.1 Special Functions for the Three Groups – Company wide Paid Exception [999] Reports (CW Paid Excep.) 

DAF CB00304  S Accessing the 
Company Wide 
DAF Folder 

Supervisors P Ability to 
access the 
CW DAF 
Folder and 
verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B11 - Appendix B   
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DAF CB00305  S Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B12 - Appendix B   

DAF CB00306  S Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B13 - Appendix B   
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DAF CB00307  S Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B14 - Appendix A   

DAF CB00308  O Accessing the 
Company Wide 
DAF Folder 

Officers P Ability to 
access the 
CW DAF 
Folder and 
verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B11 - Appendix B   
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DAF CB00309  O Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B12 - Appendix B   

DAF CB00310  O Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B13 - Appendix B   
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DAF CB00311  O Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B14 - Appendix A   

DAF CB00312  A Accessing the 
Company Wide 
DAF Folder 

Auditors P Ability to 
access the 
CW DAF 
Folder and 
verify list of 
reports are 
included in 
the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” and press 
Search. 

Screen B11 - Appendix B   
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DAF CB00313  A Accessing the 
various reports 
based on the 
status  

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Pending 
from the drop-down options 

5. Press Search. 

Screen B12 - Appendix B   

DAF CB00314  A Accessing the 
various reports 
based on the 
status  

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select Actioned 
from the drop-down options 

5. Press Search. 

Screen B13 - Appendix B   
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DAF CB00315  A Accessing the 
various reports 
based on the 
status  

Search by 
“UnActioned” 

P Ability to 
search for 
“UnActione
d” reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Status field select 
UnActioned from the drop-down options 

5. Press Search. 

Screen B14 - Appendix A   

DAF CB00316  S Comp
any 
Wide 
Paid 
Except
ion  

 

Sup Search by 
Report 

P Verify report 
is included 
in the folder 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range e.g. “Between 
01/01/01 and 12/31/01” 

4. In the Report Description field select 
Company Wide Paid Exception from  
the drop-down options 

5. Press Search. 

Screen B15 - Appendix A   

DAF CB00317  S Comp
any 
Wide 
Paid 
Excep
tion  

Sup Change status to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pend. 

Screen B16 - Appendix A   

DAF CB00318  S Comp Sup Change status to P Ability to 1. From the above screen, under Report Screen B17 - Appendix A   
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any 
Wide 
Paid 
Excep
tion  

Actioned change the 
status of 
report to 
Actioned 

Description, select Company Wide Paid 
Exception and press Action. 

DAF CB00319  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Change status to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pend. 

Screen B16 - Appendix A   

DAF CB00320  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Change status to 
Actioned 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Action. 

Screen B17 - Appendix A   

DAF CB00321  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Search by 
“Pending” 

P Ability to 
search for 
“Pending” 
Company 
Wide Paid 
Exception 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 
Company Wide Paid Exception from the 
drop down options 

5. In the Report Status field select Pending 
from the drop-down options 

6. Press Search. 

Screen B18 - Appendix B   
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DAF CB00322  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Search by 
“Actioned” 

P Ability to 
search for 
“Actioned” 
Company 
Wide  Paid 
Exception 
reports  

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 
Company Wide Paid Exception from the 
drop down options 

5. In the Report Status field select Actioned 
from the drop-down options 

6. Press Search. 

Screen B19 - Appendix B   

DAF CB00323  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Change status 
from Actioned to 
Pending 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pending. 

Screen B16 - Appendix A   

DAF CB00324  O Comp
any 
Wide 
Paid 
Excep
tion  

Offic
ers 

Change status 
from Pending to 
Actioned 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Actioned. 

Screen B17 - Appendix A   

DAF CB00325  A Comp
any 
Wide 
Paid 
Excep

Audit
or 

Check Status P Ability to 
select a 
report and 
see the 
status 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

Screen B11 - Appendix A   
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tion  3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01”) 

4. In the Report Description field select 
Company Wide Paid Exception from the 
drop down options 

5. Press Search. 

DAF CB00326  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Change status to 
Pending 

N Inability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pend. 

Not able to change status   

DAF CB00327  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Change status to 
Actioned 

N Inability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Action. 

Not able to change status   

DAF CB00328  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Search by 
“Pending” 

P Ability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pend. 

Screen B18 - Appendix A   

DAF CB00329  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Search by 
“Actioned” 

P Ability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Action. 

Screen B19 - Appendix A   
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DAF CB00330  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Change status 
from Actioned to 
Pending 

N Inability to 
change the 
status of 
report to 
Pending 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Pending. 

Not able to change the status   

DAF CB00331  A Comp
any 
Wide 
Paid 
Excep
tion  

Audit
or 

Change status 
from  Pending to 
Actioned 

N Inability to 
change the 
status of 
report to 
Actioned 

1. From the above screen, under Report 
Description, select Company Wide Paid 
Exception and press Actioned. 

Not able to change the status   
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3.4 End Users Functional Testing – Searches (See Appendix C for screen images) 

3.4.1 Proper Format for each Folder  

 CB00332   Cheque SN  Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C1 - Appendix C 

(Screen images to be 

included using 17” 

monitor) 

  

 CB00333   Int.A/c.Bal. Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts : 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C2 - Appendix C   
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 CB00334   General Report Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C3 - Appendix C   

 CB00335   CRS A/c.No. Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C4 - Appendix C   
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 CB00336   Ext. A/c. Issued 
File Balancing 

Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External Accts: 
Issued File Balancing View and press 
Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C5 - Appendix C   

 CB00337   Ext. A/c. Paid 
File Balancing 

Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External Accts: 
Paid File Balancing View and press 
Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C6 - Appendix C   
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 CB00338   DAF Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C7 - Appendix C   

 CB00339   Company wide 
DAF 

Date Range P To ensure 
the 
information 
on the 
reports for 
each folder 
appears 
correctly in 
the 
Document 
List 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. Press Search. 

Screen C8 - Appendix C   
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3.4.2 Three SOPs for Search, for each Report across all Folders 

3.4.2.1 Cheque Serial No. Folder 

SRC CB00340  S Stop Payment 
304 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
304 reports 
in the 
selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Description field, select 
304 Stop Payment from the drop-down 
options. 

5. Press Search. 

Screen C9 – Appendix C   

SRC CB00341  S Stop Payment 
304 

Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 

Screen C10  – Appendix C   
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(e.g. 1830) 

6. Press Search. 

SRC CB00342  S Stop Payment 
304 

Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 1830) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 304 Stop 
Payment) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
31100) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

9. Press Search. 

Screen C11 – Appendix C   

 CB00343  S Cancelled 
Items 304 

Date Range P Verify valid 
date range 

1. After logging in, select All from the Open Screen C12 – Appendix C   
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works 
(gives a list 
of all the 
304 
Cancelled 
Items 
reports in 
the selected 
date range) 

a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 12/31/01” ) 

4. In the Report Description field, select 
304 Cancelled Items from the drop-down 
options. 

5. Press Search. 

 CB00344  S Cancelled 
Items 304 

Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 205)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 463489) 

6. Press Search. 

Screen C13 – Appendix C   

 CB00345  S Cancelled 
Items 304 

Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 

P Verify the 
correct 
report is 
accessed 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 

Screen C14– Appendix C   
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+ Company No. 
+ CompaName 

after keying 
the 6 fields 

Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 205)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 463489) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 304 Cancelled 
items) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
30000) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Internal%) 

9. Press Search. 

 CB00346  S Void Items 304 Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
304 Void 
Items 
reports in 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen C15 – Appendix C   
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the selected 
date range) 

4. In the Report Description field, select 
304 Void Items from the drop-down 
options. 

5. Press Search. 

 CB00347  S Void Items 304 Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 11908)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 27628) 

6. Press Search. 

Screen C16 – Appendix C   

 CB00348  S Void Items 304 Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C17– Appendix C   
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(e.g. 11908)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 27628) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 304 Void items) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
50000) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Franklin%) 

9. Press Search. 

 CB00349  S Trace List 306 Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
306 Trace 
List reports 
in the 
selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
306 Trace List from the drop-down 
options. 

5. Press Search. 

Screen C18 – Appendix C   

 CB00350  S Trace List 306 Date range + 
CRS Account + 

P Verify the 
correct 
report is 

1. After logging in, select All from the Open 
a Folder screen. 

Screen C19 – Appendix C   
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Cheque SN accessed 
after keying 
the 3 fields 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 154865) 

6. Press Search. 

 CB00351  S Trace List 306 Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 154865) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 306 Trace List) 

Screen C20 – Appendix C   
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7. In the Company Number field enter the 
company number you are searching (e.g. 
31100) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

9. Press Search. 

 CB00352  S  Company wide 
Maintenance 3 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Company 
Wide 
Maintenanc
e 3 reports 
in the 
selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 3 Company Wide Maintenance from 
the drop-down options. 

5. Press Search. 

Screen C21 – Appendix C   

 CB00353  S Company wide 
Maintenance 3 

Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C22 – Appendix C   
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(e.g. 0)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 1266) 

6. Press Search. 

 CB00354  S Company wide 
Maintenance 3 

Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 1266) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Rpt.3 Company 
Wide Maintenance) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
11000) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

Screen C23 – Appendix C   
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9. Press Search. 

 CB00355  S Reversal 
Register 8 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Reversal 
Register 8 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Report 8 Reversal Register from the 
drop-down options. 

5. Press Search. 

Screen C24 – Appendix C   

 CB00356  S Reversal 
Register 8 

Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 1266) 

6. Press Search. 

Screen C25 – Appendix C   
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 CB00357  S Reversal 
Register 8 

Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 3808)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 4402522) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Report 8 Reversal 
Register) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
24000) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. TOR%) 

9. Press Search. 

Screen C26 – Appendix C   

 CB00358  S Dormant 
Account [992] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

Screen C27 – Appendix C   
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Dormant 
Account 
reports in 
the selected 
date range) 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Dormant Account Report from the drop-
down options. 

5. Press Search. 

 CB00359  S Dormant 
Account [992] 

Date range + 
CRS Account + 
Cheque SN 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g.1252)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g.887067) 

6. Press Search. 

Screen C28 – Appendix C   

 CB00360  S Dormant 
Account [992] 

Date range + 
CRS Account + 
Cheque SN + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 6 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 

Screen C29 – Appendix C   
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01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 1252)  

5. In the Cheque Serial Number field enter 
the Cheque number you are searching 
(e.g. 887067) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Dormant Report) 

7. In the Company Number field enter the 
company number you are searching (e.g. 
30000) 

8. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. PMO%) 

9. Press Search. 
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3.4.2.2 Internal Account Balancing Folder 

SRC CB00361  S Outstanding 
Issues 305 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
305 
Outstanding 
Issues 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
305 Outstanding Issues from the drop-
down options. 

5. Press Search. 

Screen C30 – Appendix C   

SRC CB00362  S Outstanding 
Issues 305 

Date range + 
CRS Account + 
Company No. 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4782)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

Screen C31 – Appendix C   
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SRC CB00363  S Outstanding 
Issues 305 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4782)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 305 Outstanding 
Issues) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. BCE%) 

8. Press Search. 

Screen C32 – Appendix C   

SRC CB00364  S Input Journal 
Summary 1 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Report 1 
Input 
Journal 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen C33 – Appendix C   
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Summary 
reports in 
the selected 
date range) 

4. In the Report Description field, select 
Report 1 Input Journal Summary from 
the drop-down options. 

5. Press Search. 

SRC CB00365  S Input Journal 
Summary 1 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4014)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

Screen C34 – Appendix C   

SRC CB00366  S Input Journal 
Summary 1 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C35 – Appendix C   
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(e.g. 4014)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Report 1 Input 
Journal Summary) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. CANADIAN%) 

8. Press Search. 

SRC CB00367  S FRS Daily 
Report: 
Account 
Balance 7 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Rpt 7 FRS 
Daily:Accou
nt Balance 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 7 FRS Daily:Account Balance from 
the drop-down options. 

5. Press Search. 

Screen C36 – Appendix C   

SRC CB00368  S FRS Daily 
Report: 
Account 
Balance 7 

Date range + 
CRS Account + 
Company No. 

P Verify the 
correct 
report is 
accessed 
after keying 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

Screen C37 – Appendix C   
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the 3 fields 3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8036)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. Press Search. 

SRC CB00369  S FRS Daily 
Report: 
Account 
Balance 7 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8036)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Rpt 7 FRS 
Daily:Account Balance) 

7. In the Company Name field enter the 

Screen C38 – Appendix C   
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company name you are searching 
followed by a “%” (e.g. DIRECT%) 

8. Press Search. 

SRC CB00370  S List of Drafts 
for CRS 
Reimbursemen
ts [991] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
List of 
Drafts for 
CRS 
Reimburse
ments 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
List of Drafts for CRS Reimbursements 
from the drop-down options. 

5. Press Search. 

Screen C39 – Appendix C   

SRC CB00371  S List of Drafts 
for CRS 
Reimbursemen
ts [991] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 3808)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
10358) 

Screen C40 – Appendix C   
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6. Press Search. 

SRC CB00372  S List of Drafts 
for CRS 
Reimbursemen
ts [991] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 3808)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
10358) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. List of Drafts for 
CRS Reimbursements) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. ___%) 

8. Press Search. 

Screen C41 – Appendix C   

SRC CB00373  S List of Drafts 
for CRS 
Replacements 
[990] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
List of 
Drafts for 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 

Screen C42 – Appendix C   
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CRS 
Replaceme
nts reports 
in the 
selected 
date range) 

01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
List of Drafts for CRS Replacements 
from the drop-down options. 

5. Press Search. 

SRC CB00374  S List of Drafts 
for CRS 
Replacements 
[990] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 3808)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
10358) 

6. Press Search. 

Screen C43 – Appendix C   

SRC CB00375  S List of Drafts 
for CRS 
Replacements 
[990] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Internal Accts: 
Balancing View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 

Screen C44 – Appendix C   
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account number you are searching on 
(e.g. 3808)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
10358) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. List of Drafts for 
CRS Replacements) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. ___%) 

8. Press Search. 

 

3.4.2.3 General Report Folder 

SRC CB00376  S Company wide 
Input Journal 
Summary 1 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Rpt 1 
Company 
Wide Input 
Journal 
Summary 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 1 Company Wide Input Journal 
Summary from the drop-down options. 

5. Press Search. 

Screen C45 – Appendix C   
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SRC CB00377  S Company wide 
Input Journal 
Summary 1 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

Screen C46 – Appendix C   

SRC CB00378  S Company wide 
Input Journal 
Summary 1 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 

Screen C47 – Appendix C   
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report you want to search for from the 
drop down options (e.g. Rpt 1 Company 
Wide Input Journal Summary) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. MONTREAL%) 

8. Press Search. 

SRC CB00379  S Company wide 
Input Journal 
Reject 2 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Rpt 2 
Company 
Wide Input 
Journal 
Reject 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 2 Company Wide Input Journal 
Reject from the drop-down options. 

5. Press Search. 

Screen C48 – Appendix C   

SRC CB00380  S Company wide 
Input Journal 
Reject 2 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C49 – Appendix C   
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(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

SRC CB00381  S Company wide 
Input Journal 
Reject 2 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Rpt 2 Company 
Wide Input Journal Reject) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. MONTREAL%) 

8. Press Search. 

Screen C50 – Appendix C   

SRC CB00382  S Purged 
Transactions 6 

Date Range P Verify valid 
date range 

1. After logging in, select All from the Open Screen C51 – Appendix C   
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works 
(gives a list 
of all the 
Report 6 
Purged 
Transaction
s reports in 
the selected 
date range) 

a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Report 6 Purged Transactions from the 
drop-down options. 

5. Press Search. 

SRC CB00383  S Purged 
Transactions 6 

Date range + 
CRS Account + 
Company 
Number 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4146)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
31100) 

6. Press Search. 

Screen C52 – Appendix C   

SRC CB00384  S Purged 
Transactions 6 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 

P Verify the 
correct 
report is 
accessed 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 

Screen C53 – Appendix C   
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+ Company 
Name 

after keying 
the 5 fields 

View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4146)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
31100) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Report 6 Purged 
Transactions) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. DIRECT%) 

8. Press Search. 

SRC CB00385  S Reversal 
Register Report 
11 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Report 11 
Reversal 
Register 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Report 11 Reversal Register from the 
drop-down options. 

Screen C54 – Appendix C   
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5. Press Search. 

SRC CB00386  S Reversal 
Register Report 
11 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8184)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. Press Search. 

Screen C55 – Appendix C   

SRC CB00387  S Reversal 
Register Report 
11 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8184)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 

Screen C56 – Appendix C   
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21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Report 11 
Reversal Register) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. capital%) 

8. Press Search. 

SRC CB00388  S FRS Daily 
Lodge: 
/Remove Stop 
Summary [996] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
FRS Daily 
Lodge: 
/Remove 
Stop 
Summary 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
FRS Daily Lodge: /Remove Stop 
Summary from the drop-down options. 

5. Press Search. 

Screen C57 – Appendix C   

SRC CB00389  S FRS Daily 
Lodge: 
/Remove Stop 
Summary [996] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen C58 – Appendix C   
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4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

SRC CB00390  S FRS Daily 
Lodge: 
/Remove Stop 
Summary [996] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. FRS Daily Lodge: 
/Remove Stop Summary) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. montreal%) 

8. Press Search. 

Screen C59 – Appendix C   
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SRC CB00391  S CRS Account 
Summary 490 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
490 CRS 
Account 
Summary 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
490 CRS Account Summary from the 
drop-down options. 

5. Press Search. 

Screen C60 – Appendix C   

SRC CB00392  S CRS Account 
Summary 490 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Report Description field, select 
490 CRS Account Summary from the 
drop-down options. 

6. Press Search. 

Screen C61 – Appendix C   

SRC CB00393  S CRS Account 
Summary 490 

Date range + 
CRS Account + 
Report Descrip. 

P Verify the 
correct 
report is 

1. After logging in, select All from the Open 
a Folder screen. 

Screen C62 – Appendix C   
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+ Company No. 
+ Company 
Name 

accessed 
after keying 
the 5 fields 

2. Select ABC Reports – General Report 
View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 0)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
0) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 490 CRS Account 
Summary) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Toronto%) 

8. Press Search. 
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3.4.2.4 CRS Account No. Folder 

SRC CB00394  S Company wide 
Paid No Issue 
[998] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Company 
Wide Paid 
No Issue 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Company Wide Paid No Issue from the 
drop-down options. 

5. Press Search. 

Screen C63 – Appendix C   

SRC CB00395  S Company wide 
Paid No Issue 
[998] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8109)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. Press Search. 

Screen C64 – Appendix C   
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SRC CB00396  S Company wide 
Paid No Issue 
[998] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8109)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Company Wide 
Paid No Issue) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. calgary%) 

8. Press Search. 

Screen C65 – Appendix C   

SRC CB00397  S FRS Daily 
Report: Daily 
Lodge Stop 
[997] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
FRS Daily 
Report: 
Daily Lodge 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen C66 – Appendix C   



SOPs for OnDemand 

 Archive Project - SOPs 152 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

Stop reports 
in the 
selected 
date range) 

4. In the Report Description field, select 
FRS Daily Report: Daily Lodge Stop 
from the drop-down options. 

5. Press Search. 

SRC CB00398  S FRS Daily 
Report: Daily 
Lodge Stop 
[997] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4324)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. Press Search. 

Screen C67 – Appendix C   

SRC CB00399  S FRS Daily 
Report: Daily 
Lodge Stop 
[997] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C68 – Appendix C   
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(e.g. 4324)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. FRS Daily Report: 
Daily Lodge Stop) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. MONTREAL%) 

8. Press Search. 

SRC CB00400  S FRS Daily 
Report: Paid 
Against Stop 
[995] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
FRS Daily 
Report: 
Daily Lodge 
Stop reports 
in the 
selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
FRS Daily Report: Paid Against Stop 
from the drop-down options. 

5. Press Search. 

Screen C69 – Appendix C   

SRC CB00401  S FRS Daily 
Report: Paid 
Against Stop 
[995] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

Screen C70 – Appendix C   
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Remarks 

the 3 fields 3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4782)  

5. In the Report Description field select 
FRS Daily Report: Paid Against Stop 
from the drop-down options. 

6. Press Search. 

SRC CB00402  S FRS Daily 
Report: Paid 
Against Stop 
[995] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – CRS Account 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4782)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. FRS Daily Report: 
Paid Against Stop) 

7. In the Company Name field enter the 

Screen C71 – Appendix C   
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company name you are searching 
followed by a “%” (e.g. MONTREAL%) 

8. Press Search. 

3.4.2.5 External Accounts Issued File Balance Folder 

SRC CB00403  S File 
Maintenance 
Register 3 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Report 3 
Maintenanc
e reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Report 3 Maintenance from the drop-
down options. 

5. Press Search. 

Screen C72 – Appendix C   

SRC CB00404  S File 
Maintenance 
Register 3 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 299)  
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5. In the Report Description field select 
Report 3 Maintenance from the drop-
down options. 

6. Press Search. 

SRC CB00405  S File 
Maintenance 
Register 3 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 299)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
10000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Report 3 
Maintenance) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. REED%) 

8. Press Search. 

Screen C74 – Appendix C   

SRC CB00406  S FRS Daily 
Report: Online 

Date Range P Verify valid 
date range 

1. After logging in, select All from the Open 
a Folder screen. 

Screen C75 – Appendix C   



SOPs for OnDemand 

Archive Project - SOPs for OnDemand – CRS Dept. , (Draft 5)  157 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

Cancel Report 
[994] 

works 
(gives a list 
of all the 
FRS Daily 
Report: 
Online 
Cancel 
reports in 
the selected 
date range) 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
FRS Daily Report: Online Cancel Report 
from the drop-down options. 

5. Press Search. 

SRC CB00407  S FRS Daily 
Report: Online 
Cancel Report 
[994] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 11614)  

5. In the Report Description field select 
FRS Daily Report: Online Cancel from 
the drop-down options. 

6. Press Search. 

Screen C76 – Appendix C   

SRC CB00408  S FRS Daily 
Report: Online 
Cancel Report 

Date range + 
CRS Account + 
Report Descrip. 

P Verify the 
correct 
report is 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
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[994] + Company No. 
+ Company 
Name 

accessed 
after keying 
the 5 fields 

Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 11614)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. FRS Daily Report: 
Online Cancel) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. anadarko%) 

8. Press Search. 

SRC CB00409  S FRS Daily 
Report:: Online 
Issues Report 
[993] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
FRS Daily 
Report: 
Online 
Issues 
reports in 
the selected 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 

Screen C78 – Appendix C   
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date range) FRS Daily Report: Online Issues Report 
from the drop-down options. 

5. Press Search. 

SRC CB00410  S FRS Daily 
Report:: Online 
Issues Report 
[993] 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8192)  

5. In the Report Description field select 
FRS Daily Report: Online Issues from 
the drop-down options. 

6. Press Search. 

Screen C79 – Appendix C   

SRC CB00411  S FRS Daily 
Report:: Online 
Issues Report 
[993] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Issued File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C80 – Appendix C   
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(e.g. 8192)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. FRS Daily Report: 
Online Cancel) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

8. Press Search. 

3.4.2.6 External Accounts Paid File Balance Folder 

SRC CB00412  S Report 2 Input 
Journal Reject 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Report 2 
Input 
Journal 
Reject 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Report 2 Input Journal Reject Report 
from the drop-down options. 

5. Press Search. 

Screen C81 – Appendix C   

SRC CB00413  S Report 2 Input 
Journal Reject 

Date range + 
CRS Account + 

P Verify the 
correct 

1. After logging in, select All from the Open 
a Folder screen. 

Screen C82 – Appendix C   
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Report 
Description 

report is 
accessed 
after keying 
the 3 fields 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4014)  

5. In the Report Description field select 
Report 2 Input Journal Reject from the 
drop-down options. 

6. Press Search. 

SRC CB00414  S Report 2 Input 
Journal Reject 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4014)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 

Screen C83 – Appendix C   
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report you want to search for from the 
drop down options (e.g. Report 2 Input 
Journal Reject) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Canadian%) 

8. Press Search. 

SRC CB00415  S Rpt 4 Duplicate 
Serial Number 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Rpt 4 
Duplicate 
Serial 
Number 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 4 Duplicate Serial Number from the 
drop-down options. 

5. Press Search. 

Screen C84 – Appendix C   

SRC CB00416  S Rpt 4 Duplicate 
Serial Number 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 

Screen C85 – Appendix C   
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account number you are searching on 
(e.g. 4502)  

5. In the Report Description field select Rpt 
4 Duplicate Serial Number from the drop-
down options. 

6. Press Search. 

SRC CB00417  S Rpt 4 Duplicate 
Serial Number 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4502)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Rpt 4 Duplicate 
Serial Number) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Canada%) 

8. Press Search. 

Screen C86 – Appendix C   



SOPs for OnDemand 

 Archive Project - SOPs 164 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

SRC CB00418  S 301 Paid Items  Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
301 Paid 
Items 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Rpt 4 Duplicate Serial Number from the 
drop-down options. 

5. Press Search. 

Screen C87 – Appendix C   

SRC CB00419  S 301 Paid Items  Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Report Description field select 301 
Paid Items from the drop-down options. 

6. Press Search. 

Screen C88 – Appendix C   

SRC CB00420  S 301 Paid Items  Date range + 
CRS Account + 

P Verify the 
correct 

1. After logging in, select All from the Open Screen C89 – Appendix C   
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Report Descrip. 
+ Company No. 
+ Company 
Name 

report is 
accessed 
after keying 
the 5 fields 

a Folder screen. 

2. Select ABC Reports – External 
Accounts Paid File Balance View and 
press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4243)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
31100) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 301 Paid Items) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

8. Press Search. 
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3.4.2.7 Document Audit Facility (DAF) Folder 

SRC CB00421  S Paid Exception 
302 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
302 Paid 
Exception 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
302 Paid Exception from the drop-down 
options. 

5. Press Search. 

Screen C90 – Appendix C   

SRC CB00422  S Paid 
Exceptions 302 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4014)  

5. In the Report Description field select 302 
Paid Exception from the drop-down 
options. 

6. Press Search. 

Screen C91 – Appendix C   
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SRC CB00423  S Paid 
Exceptions 302 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 4014)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
11000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 302 Paid 
Exception) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Canadian%) 

8. Press Search. 

Screen C92 – Appendix C   

SRC CB00424  S Paid No Issue 
303 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
302 Paid 
No Issue 
reports in 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen C93 – Appendix C   
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the selected 
date range) 

4. In the Report Description field, select 
303 Paid No Issue from the drop-down 
options. 

5. Press Search. 

SRC CB00425  S Paid No Issue 
303 

Date range + 
CRS Account + 
Report 
Description 

P Verify the 
correct 
report is 
accessed 
after keying 
the 3 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8192)  

5. In the Report Description field select 303 
Paid No Issue from the drop-down 
options. 

6. Press Search. 

Screen C94 – Appendix C   

SRC CB00426  S Paid No Issue 
303 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 
and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 

Screen C95 – Appendix C   
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(e.g. 8192)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. 303 Paid No 
Issue) 

7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Branch%) 

8. Press Search. 

3.4.2.8 Company wide DAF Folder 

SRC CB00427  S Company wide 
Paid Exception 
[999] 

Date Range P Verify valid 
date range 
works 
(gives a list 
of all the 
Company 
wide Paid 
Exception 
reports in 
the selected 
date range) 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field, select 
Company wide Paid Exception from the 
drop-down options. 

5. Press Search. 

Screen C96 – Appendix C   

SRC CB00428  S Company wide 
Paid Exception 
[999] 

Date range + 
CRS Account + 
Report 

P Verify the 
correct 
report is 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – DAF Report View 

Screen C97 – Appendix C   
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Description accessed 
after keying 
the 3 fields 

and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8257)  

5. In the Report Description field select 
Company wide Paid Exception from the 
drop-down options. 

6. Press Search. 

SRC CB00429  S Company wide 
Paid Exception 
[999] 

Date range + 
CRS Account + 
Report Descrip. 
+ Company No. 
+ Company 
Name 

P Verify the 
correct 
report is 
accessed 
after keying 
the 5 fields 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Company Wide 
DAF Report View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the CRS Account field, enter the 
account number you are searching on 
(e.g. 8257)  

5. In the Company Number field enter the 
Company number you are searching (e.g. 
21000) 

6. In the Report Description field enter the 
report you want to search for from the 
drop down options (e.g. Company Wide 
Paid Exception) 

Screen C98 – Appendix C   
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7. In the Company Name field enter the 
company name you are searching 
followed by a “%” (e.g. Calgary%) 

8. Press Search. 
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3.4.3 By Find Command (See Appendix D for screen images of test results) 

3.4.3.1 Cheque Serial No. Folder 

 

SRC CB00430  S Paid Items 
Report 301 

Find Cheque S/N 
- Button 

P Find 
cheque SN 
in a report 
using the 
button 
feature 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the Find the 
specified text string button (5th button 
from the left) 

8. From the Find screen, in the String field, 
enter the Cheque Serial Number you are 
searching on (e.g.154865) and press the 
Find button. 

Screen D1 – Appendix D   

SRC CB00431  S Paid Items 
Report 301 

Find Cheque S/N 
- Button 

N Invalid 
cheque SN 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 

Screen D2 – Appendix D   
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Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the Find the 
specified text string button (5th button 
from the left) 

8. From the Find screen, in the String field, 
enter an incorrect Cheque Serial Number 
you are searching on (e.g.174567) and 
press the Find button. 

SRC CB00432  S Paid Items 
Report 301 

Find Cheque S/N 
- Menu 

P Find a 
cheque SN 
in a report 
using the 
menu/F5 
feature 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 

Screen D1 – Appendix D   
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key. 

7. From the opened report, click the F5 
function key. 

8. From the Find screen, in the String field, 
enter the Cheque Serial Number you are 
searching on (e.g.154865) and press the 
Find button. 

SRC CB00433  S Paid Items 
Report 301 

Find Cheque S/N 
- Menu 

N Invalid 
cheque SN 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the F5 
function key. 

8. From the Find screen, in the String field, 
enter an incorrect Cheque Serial Number 
you are searching on (e.g.174567) and 
press the Find button. 

Screen D2 – Appendix D   

SRC CB00434  S Paid Items 
Report 301 

Find $ amount - 
Button 

P Find a $ 
amount in a 
report using 

1. After logging in, select All from the Open 
a Folder screen. 

Screen D3 – Appendix A   
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the button 
feature 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the Find the 
specified text string button (5th button 
from the left) 

8. From the Find screen, in the String field, 
enter the $ amount you are searching on 
(e.g.237.82) and press the Find button. 

SRC CB00435  S Paid Items 
Report 301 

Find $ amount - 
Button 

N Invalid $ 
amount 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 

Screen D4 – Appendix D   
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key. 

7. From the opened report, click the Find the 
specified text string button (5th button 
from the left) 

8. From the Find screen, in the String field, 
enter an incorrect $ amount 
(e.g.1234567237.82) and press the Find 
button. 

SRC CB00436  S Paid Items 
Report 301 

Find $ amount - 
Menu 

P Find a $ 
amount in a 
report  
using the 
menu/F5 
feature 

1. After logging in, select All from the Open 
a Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the F5 
function key. 

8. From the Find screen, in the String field, 
enter the $ amount you are searching on 
(e.g.237.82) and press the Find button. 

Screen D3 – Appendix A   

SRC CB00437  S Paid Items 
Report 301 

Find $ amount - 
Menu 

N Invalid $ 
amount S/N 

1. After logging in, select All from the Open 
a Folder screen. 

Screen D4 – Appendix D   
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2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. From the opened report, click the F5 
function key. 

8. From the Find screen, in the String field, 
enter an incorrect $ amount 
(e.g.1234567237.82) and press the Find 
button. 

3.4.4 By Logical / Expression Find  

3.4.4.1 For the following reports (Cheque Serial Number Folder): 

- Paid Items Report – 301 

- Paid Exceptions Report – 302 

- Outstanding Issues Report - 305 

SRC CB00438   Paid Items 
Report 301 

Expression Find 
– 

Cheque S/N 

P Cheque Serial 
No. only 

1. After logging in, select All from the 
Open a Folder screen. 

2. Select ABC Reports – Cheque Serial 

Screen D5 – Appendix D   
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Number View and press Open. 

3. From the Folder Search Screen select 
the appropriate date range (e.g. 
“Between 01/01/01 and 01/01/02”) 

4. In the Report Description field select 
301 Paid Items from the drop-down 
options. 

5. Press Search. 

6. Open the report by pressing the Enter 
key. 

7. Select Expression Find from the 
Search pulldown menu 

8. Highlight SERIALNUM and press the 
Insert button. 

9. SERIALNUM appears in the 
Expression field. 

10. Select  “=” from the Fields box;  press 
the Insert button. 

11. Key in the cheque serial number to 
be located (e.g. 160027); press the 
Find button. 

SRC CB00439   Paid Items 
Report 301 

Expression Find 
– 

Cheque S/N 

N Incorrect 
Cheque Serial 
No.  

1. After logging in, select All from the Open a 
Folder screen. 

2. Select ABC Reports – Cheque Serial 
Number View and press Open. 

3. In the next screen that appears select the 
appropriate date range (e.g. “Between 

Screen __ – Appendix D   
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01/01/01 and 01/01/02”) 

4. In the Report Description field select 301 
Paid Items from the drop-down options. 

5. Press Search. 

6. Open the report by pressing the Enter key. 

7. From the opened report, click the F5 
function key. 

8. From the Find screen, in the String field, 
enter an incorrect $ amount 
(e.g.1234567237.82) and press the Find 
button. 

SRC CB00440   Paid Items 
Report 301 

Expression Find 
– Find All: 

- Date Range 
- Cheque SN 
- Report/s 
 

P - Date Range 
- Cheque SN 
- Report/s 
 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 301 
Paid Items from the drop-down options. 

4. Press Search. 

5. Open the report by pressing the Enter key. 

6. From the opened report, select the Search 
menu. 

7. Select Expression Find from the list of 
options 

8. Highlight SERIALNUM and press the Insert 
button. 
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9. Select  “>=” from the Fields box; press the 
Insert button. 

10. Key in the beginning cheque serial 
number you are searching on (e.g. 165457).  

11. Insert the “logical AND” (&) search 
operator. 

12. Highlight SERIALNUM and press the 
Insert button. 

13. Select  “<=” from the Fields box; press the 
Insert button. 

14. Key in the ending cheque serial number 
you are searching on (e.g. 165457). 

15. Press the Find All button. 

 

SRC CB00441   Paid Items 
Report 301 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
 

N Incorrect: 
- Date Range 
- Cheque SN 
- Report/s 
 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 301 
Paid Items from the drop-down options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. From the opened report, select the Search 
menu. 

7. Select Expression Find from the list of 
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options 

8. Highlight ISSUEDATE and press the Insert 
button. 

9. Select  “>=” from the Fields box; press the 
Insert button. 

10. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

11. Insert the “logical AND” (&) search 
operator. 

12. Highlight ISSUEDATE and press the 
Insert button. 

13. Select  “<=” from the Fields box; press the 
Insert button. 

14. Key in the ending ISSUEDATE to be 
searched on (e.g. 063001). 

15. Press the Find button. 

SRC CB00442   Paid Items 
Report 301 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

P - Date Range 
- Cheque SN 
- Report/s 
Search Result 
– Move to a 
selected row 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 301 
Paid Items from the drop-down options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. From the opened report, select the Search 
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menu. 

7. Select Expression Find from the list of 
options 

8. Highlight ISSUEDATE and press the Insert 
button. 

9. Select  “>=” from the Fields box; press the 
Insert button. 

10. Key in the ISSUEDATE to be searched 
042701).  

11. Press the Find All button. 

12. Double click on the last entry of the 
record entries to go directly to that line 
entry. 

SRC CB00443   Paid Items 
Report 301 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

N Incorrect 
- Date Range 
- Cheque SN 
- Report/s 
Search Result 
– One row 
selected 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 301 
Paid Items from the drop-down options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. From the opened report, select Expression 
Find from the Search menu. 

7. Highlight ISSUEDATE and press the Insert 
button. 
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8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 
searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button. 

17. Key in the cheque number to be located 
(e.g. 0005178674);  press the Find button. 

18. Press the Find button. 

SRC CB00444   Paid 
Exceptions 
Report - 302 

Expression Find 
– 

Cheque S/N 

P Cheque Serial 
No. only 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. In the Folder Search Screen enter an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 302 
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Paid Exception from the drop-down 
options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. Select Expression Find from the Search 
menu. 

7. In the Expression Find screen, highlight 
SERIALNUM: press the Insert button. 

8. SERIALNUM appears in the Expression 
field. 

9. Select  “=” from the Fields box; press the 
Insert button. 

10. Key in the cheque number to be located 
(e.g. 0005178674);  press the Find button. 

SRC CB00445   Paid 
Exceptions 
Report - 302 

Expression Find 
– 

Cheque S/N 

N Incorrect 
Cheque Serial 
No.  

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. In the Folder Search Screen enter an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. In the Report Description field select 302 
Paid Exception from the drop-down 
options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. Select Expression Find from the Search 
menu. 
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7. In the Expression Find screen, highlight 
SERIALNUM: press the Insert button. 

8. SERIALNUM appears in the Expression 
field. 

9. Select  “=” from the Fields box; press the 
Insert button. 

10. Key in the cheque number to be located 
(e.g. 0009999999);  press the Find button. 

SRC CB00446   Paid 
Exceptions 
Report - 302 

Expression Find: 

- Date Range 
- IssueAmount 
- Cheque SN 
- Report/s 
 

P - IssueAmount  
Range 
- Cheque SN 
- Report/s 
 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 302 Paid Exception from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the report by pressing Enter. 

6. Select Expression Find from the Search 
menu options. 

7. Highlight ISSUEAMOUNT and press the 
Insert button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the ISSUEAMOUNT to be searched 
150.00).  

10. Insert the “logical AND” (&) search 
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operator. 

11. Highlight ISSUEAMOUNT and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEAMOUNT to be 
searched on (e.g. 350.00 ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button. 

17. Key in the cheque number to be located 
(e.g. 0005178674);  press the Find button. 

SRC CB00447   Paid 
Exceptions 
Report - 302 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
 

N Incorrect: 
- IssueAmount 
Range 
- Cheque SN 
- Report/s 
 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 302 Paid Exception from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the report by pressing Enter. 

6. Select Expression Find from the Search 
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menu options. 

7. Highlight ISSUEAMOUNT and press the 
Insert button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the ISSUEAMOUNT to be searched 
150.00).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEAMOUNT and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEAMOUNT to be 
searched on (e.g. 350.00 ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button. 

17. Key in the cheque number to be located 
(e.g. 0005178674);  press the Find button. 

SRC CB00448   Paid 
Exceptions 
Report - 302 

Expression Find 
- All: 

- Date Range 
- IssueAmount 

P - IssueAmount  
Search Result 
– Move to a 
selected row. 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 

Screen D8 – Appendix D   
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- Cheque SN 
- Report/s 
Search Result 

01/01/01 and 01/01/02”) 

3. Select 302 Paid Exception from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. Select Expression Find from the Search 
menu options. 

7. Highlight ISSUEAMOUNT and press the 
Insert button. 

8. Select  “=” from the Fields box; press the 
Insert button. 

9. Key in the ISSUEAMOUNT to be located 
150.00).  

10. Press the Find All button. 

11. Double click on the last entry of the 
record entries to go directly to that line 
entry. 

SRC CB00449   Paid 
Exceptions 
Report - 302 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

N Incorrect 
- IssueAmount  
Search Result 
– One row 
selected 

1. Open ABC Reports – Cheque Serial 
Number View. 

2. From the Folder Search Screen select an 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 302 Paid Exception from the 
Report Description field drop-down 
options. 
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4. Press Search. 

5. View the report by pressing the Enter key. 

6. Select Expression Find from the Search 
menu options. 

7. Highlight ISSUEAMOUNT and press the 
Insert button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the ISSUEAMOUNT to be located 
1500000.00).  

10. Press the Find  button. 

SRC CB00450   Outstanding 
Issues Report 
305   
 

Expression Find 
– 

Cheque S/N 

P Cheque Serial 
No. only 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select Outstanding Issues Report 305 
from the Report Description field drop-
down options. 

4. Press Search. 

5. View the report by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu 

7. Highlight SERIALNUM; press the Insert 
button. 

8. Select  “=” from the Fields box;  press the 
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Insert button. 

9. Key in the cheque serial number to be 
located (e.g. 0007689369); press the Find 
button. 

SRC CB00451   305 
Outstanding 
Issues 

Expression Find 
– 

Cheque S/N 

N Incorrect 
Cheque Serial 
No.  

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu 

7. Highlight SERIALNUM; press the Insert 
button. 

8. Select  “=” from the Fields box;  press the 
Insert button. 

9. Key in the cheque serial number to be 
located (e.g. 0007689369); press the Find 
button. 

Screen D9 – Appendix D   

SRC CB00452   305 
Outstanding 
Issues 

Search without 
Autoview 

Date Range 

P Locate a list of 
documents 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. Select Autoview -> None from the Options 
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pull-down menu. 

3. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

5. Press Search. 

6. View the document with cheque serial 
number of 0007689369. 

SRC CB00453   305 
Outstanding 
Issues 

Search with 
Autoview 

Date Range 

P Locate a list of 
documents and 
automatically 
view first 
document 
matched 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. Select Autoview -> First Document from 
the Options pull-down menu. 

3. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

5. Press Search. 

Screen D46 – Appendix D 

Screen D17 – Appendix D 

Document should automatically 
open to the first page of the first 
document on the hit list. 

  

SRC CB00454   305 
Outstanding 
Issues  

Search with 
Autoview – First 
Document 

Date Range 
Cheque S/N 

P Locate a single 
document 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. Select Autoview -> First Document from 
the Options pull-down menu. 

3. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 

Screen D1 – Appendix D 

Document should automatically 
open to the line item searched. 
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01/01/01 and 01/01/02”) 

4. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

5. Enter Cheque S/N 0007689369 

6. Press Search. 

SRC CB00455   305 
Outstanding 
Issues 

Search with 
Autoview – 
Single 
Document 

Date Range 
Cheque S/N 

P Locate a single 
document 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. Select Autoview -> Single Document from 
the Options pull-down menu. 

3. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

4. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

5. Enter Cheque S/N 0007689369 

6. Press Search. 

Screen D1 – Appendix D 

Document should automatically 
open to the line item searched. 

  

SRC CB00456   305 
Outstanding 
Issues  

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
 

P - Date Range 
- Cheque SN 
- Report/s 
 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options.  
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4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu  

7. Highlight ISSUEDATE and press the Insert 
button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 
searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button.  

17. Key in the cheque serial number to be 
located (e.g. 0007689369); press the Find 
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button. 

SRC CB00457   305 
Outstanding 
Issues  

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
 

N Incorrect: 
- Cheque SN 
- Report/s 
 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options.  

4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu.  

7. Highlight ISSUEDATE and press the Insert 
button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 
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searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button.  

17. Key in the cheque serial number to be 
located (e.g. 0009999999); press the Find 
button. 

SRC CB00458   305 
Outstanding 
Issues 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

P - Date Range 
- Cheque SN 
- Report/s 
Search Result 
– One row 
selected 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options.  

4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu  

7. Highlight ISSUEDATE and press the Insert 
button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

Screen D10 – Appendix D   
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9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 
searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button.  

17. Key in the cheque serial number to be 
located (e.g. 0007689369); press the Find 
button. 

SRC CB00459   305 
Outstanding 
Issues 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

P Expression 
Find – Find All  
One row 
selected 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options.  

Screen D11 – Appendix D   
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4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu  

7. Highlight ISSUEDATE and press the Insert 
button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 
searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button.  

17. Key in the cheque serial number to be 
located (e.g. 0007689369); press the Find 
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All button. 

SRC CB00460   305 
Outstanding 
Issues 

Expression Find: 

- Date Range 
- Cheque SN 
- Report/s 
Search Result 

N Incorrect 
- Date Range 
- Cheque SN 
- Report/s 
Search Result 
– One row 
selected 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options.  

4. Press Search. 

5. View the report that contains Cheque S/N 
0007689369 by pressing the Enter key. 

6. Select Expression Find from the Search 
pulldown menu  

7. Highlight ISSUEDATE and press the Insert 
button. 

8. Select  “>=” from the Fields box; press the 
Insert button. 

9. Key in the beginning ISSUEDATE to be 
searched (e.g.052101).  

10. Insert the “logical AND” (&) search 
operator. 

11. Highlight ISSUEDATE and press the 
Insert button. 

12. Select  “<=” from the Fields box; press the 
Insert button. 

13. Key in the ending ISSUEDATE to be 

Screen D7 – Appendix D   
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searched on (e.g. 063001). ).  

14. Insert the “logical AND” (&) search 
operator. 

15. SERIALNUM appears in the Expression 
field. 

16. Select  “=” from the Fields box; press the 
Insert button.  

17. Key in the cheque serial number to be 
located (e.g. 0009999999); press the Find 
All button. 

3.4.5 By Logical Find (Large Reports –100 pages) –  

3.4.5.1 Cheque Serial Number Folder 

SRC CB00461  S 305 
Outstanding 
Issues 

Single View P Locate and 
View a 100-pg 
document  

Report Date 

Cheque S/N 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the document with cheque serial 
number of 0007689369. 

Screen D17 – Appendix D   

SRC CB00462  S 305 
Outstanding 

Multi View  P View multiple 
pages 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

Screen D12 – Appendix D and   
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Issues 
 

Side-by-side concurrently of 
a 100-page 
document  

Report Date 

Cheque S/N 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the document with cheque serial 
number of 0007689369. 

6. From the Options pull-down menu, activate 
MultiView 

7. From the Window pull-down menu, select 
New Window 

8. From the Window pull-down menu, select 
Tile Vertical 

9. From the left-most document window, go to 
page 39. 

10. From the right-most document window, 
go to page 70. 

Screen D13 – Appendix D 

SRC CB00463  O 305 
Outstanding 
Issues 

Multi View  

Top-to-bottom 

P View multiple 
pages 
concurrently of 
a 100-page 
document  

Report Date 

Cheque S/N 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

Screen D12 – Appendix D and 

Screen D14 – Appendix D 
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4. Press Search. 

5. View the document with cheque serial 
number of 0007689369. 

6. From the Options pull-down menu, activate 
MultiView 

7. From the Window pull-down menu, select 
New Window 

8. From the Window pull-down menu, select 
Tile Horizontall 

9. From the top-most document window, go to 
page 39. 

10. From the bottom-most document 
window, go to page 70. 

SRC CB00464  O 305 
Outstanding 
Issues 

Multi View  

Cascade 

P View multiple 
pages 
concurrently of 
a 100-page 
document  

Report Date 

Cheque S/N 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the document with cheque serial 
number of 0007689369. 

6. From the Options pull-down menu, activate 
MultiView 

7. From the Window pull-down menu, select 

Screen D12 – Appendix D and 

Screen D15 – Appendix D 
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New Window 

8. From the Window pull-down menu, select 
Cascade 

9. From the highest (the one on top) document 
window, go to page 70. 

10. From the underneath document (the 
one laying below the other one) window, go 
to page 39. 

SRC CB00465  A 305 
Outstanding 
Issues 

Multiple docs 
viewed as a 
single document 

P Separate 
documents of 
similar type can 
be viewed as a 
single 
document 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select 305 Outstanding Issues from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. From the Options pull-down menu, activate 
View Combined Documents 

6. Select 3 documents from the hit list so that 
all documents are highlighted concurrently.  

7. Press Enter to view the documents. 

Screen D16 – Appendix D 

Screen D17 – Appendix D 

  

SRC CB00466  A 305 
Outstanding 
Issues 
 

Multiple docs 
viewed as a 
single document 

N Separate 
documents of 
unlike type can 
be viewed as a 
single 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

Screen D18 – Appendix D 

Screen D19 – Appendix D 
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document 3. Press Search. 

4. From the Options pull-down menu, activate 
View Combined Documents 

5. Select 3 documents from the hit list with a 
different Report Description so that each 
document is highlighted concurrently.  

6. Press Enter to view the documents. 

3.4.6 By Logical Find (Multiple Reports)   

3.4.6.1 DAF Folder 

SRC CB00467  S 302 Paid 
Exception 

Single View P Locate and 
View a 
document  

Report Date 

Company 
Name 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 
Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp. 

Screen D17 – Apendix D   

SRC CB00468  S 302 Paid 
Exception 
 

Multi View  

Side-by-side 

P View multiple 
pages 
concurrently of 
a document  

Report Date 

Company 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 

Screen D12 – Appendix D 

Screen D13 – Appendix D 
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Name Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp 

6. From the Options pull-down menu, activate 
MultiView 

7. From the Window pull-down menu, select New 
Window 

8. From the Window pull-down menu, select Tile 
Vertical 

9. From the left-most document window, highlight 
SERIAL NUM 0005167956. 

10. From the right-most document window, 
highlight SERIAL NUM 0005180002. 

SRC CB00469  O 302 Paid 
Exception 

Multi View  

Top-to-bottom 

P View multiple 
pages 
concurrently of 
a document  

Report Date 

Company 
Name 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 
Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp 

6. From the Options pull-down menu, activate 
MultiView 

Screen D12 – Appendix D 

Screen D14 – Appendix D 
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7. From the Window pull-down menu, select New 
Window 

8. From the Window pull-down menu, select Tile 
Horizontal 

9. From the top-most document window, highlight 
SERIAL NUM 0005167956. 

10. From the bottom-most document window, 
highlight SERIAL NUM 0005180002. 

SRC CB00470  O 302 Paid 
Exception 

Multi View  

Cascade 

P View multiple 
pages 
concurrently of 
a document  

Report Date 

Company 
Name 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 
Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp 

6. From the Options pull-down menu, activate 
MultiView 

7. From the Window pull-down menu, select New 
Window 

8. From the Window pull-down menu, select 
Cascade 

9. From the top-layered document window, 
highlight SERIAL NUM 0005167956. 

10. From the bottom-layered document window, 

Screen D12 – Appendix D 

Screen D15 – Appendix D 
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highlight SERIAL NUM 0005180002. 

SRC CB00471  A 302 Paid 
Exception 

Multiple docs 
viewed as a 
single document 

P Separate 
documents of 
similar type can 
be viewed as a 
single 
document 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 
Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp 

6. From the Options pull-down menu, activate 
View Combined Document  

7. Select 2 documents from the hit list so that both 
documents are highlighted concurrently.  

8. Press Enter to view the documents. 

Screen 16 – Appendix D 

Screen 17 – Appendix D 

  

SRC CB00472  A 302 Paid 
Exception 
 

Multiple docs 
viewed as a 
single document 

N Separate 
documents of 
unlike type can 
be viewed as a 
single 
document 

1. Select ABC Reports – DAF Report View and 
press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 01/01/01 
and 01/01/02”) 

3. Select 302 Paid Exception from the Report 
Description field drop-down options. 

4. Press Search. 

5. View the document for Company Name 
Canada Post Corp 

Screen D18 – Appendix D 

Screen D19 – Appendix D 
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6. From the Options pull-down menu, activate 
View Combined Document  

7. Select 2 documents from the hit list so that both 
documents are highlighted concurrently.  

8. Press Enter to view the documents. 

3.4.7 Next Document Button  

3.4.7.1 Cheque Serial Number Folder 

SRC CB00473  S FRS Daily 
Report: 
Online Issues 

Search and obtain 
more than 1 result 

P  1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select the 
appropriate date range (e.g. “Between 
01/01/01 and 01/01/02”) 

3. Select FRS Daily Report: Online Issues 
from the Report Description field drop-
down options. 

4. Press Search. 

Screen D23 – Appendix D   

SRC CB00474  S FRS Daily 
Report: 
Online Issues 

Open first 
document 

P  1. Highlight the CRS Account 8192 
document; then press Enter to view the 
document. 

2. Open Windows Explore to verify that a 
single document has been placed in the 
c:\Program Files\IBM\OnDemand32\Data 
directory. The name of the file will be 
similar to D3-11c.A32 

Screen D23 – Appendix D 

Screen D24 – Appendix D 

  

SRC CB00475  S FRS Daily 
Report: 

Up and Down   Verify 
documents 

1. While viewing the document, close the 
current document and open the next 

Screen D20 – Appendix D   
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Online Issues buttons can be open 
from within 
another 
open 
document 

document on the hit list (CRS Account 
8737)  

2. Click on the Down arrow to open the next 
document from the hit list. 

3. Click on the Up arrow to open the 
previous document listed on the hit list 
(CRS Account 8192).  

4. Open Windows Explore to verify that only 
a single document has been placed in the 
c:\Program Files\IBM\OnDemand32\Data 
directory. The name of the file will be 
similar to D4-11c.A32  

Screen D21 – Appendix D 

Screen D24 – Appendix D 

SRC CB00476  S Dormant 
Account 
Report 

Search and obtain 
more than 1 result 
without closing 
documents 

  1. While still viewing CRS Account 8192, 
click on the Folder Search Screen icon. 

2. Select Dormant Account Report from 
the Report Description pull-down field. 

3. Press search 

Screen D22 – Appendix D   

SRC CB00477  S Dormant 
Account 
Report 

View an 
additional 
document 

  1. Highlight the CRS Account 1287 
document; then press Enter to view the 
document. 

2. Open Windows Explore to verify that a 
second document has been placed in the 
c:\Program Files\IBM\OnDemand32\Data 
directory. The name of the file will be 
similar to D3-11c.A32 

Screen D25 – Appendix D   

SRC CB00478  S Dormant 
Account 
Report 

View an open 
document 

  1. While viewing a document, view another 
currently opened document.   

2. Click on the Right arrow to open the next 

Screen D26 – Appendix D 

Screen D27 – Appendix D 
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document that is currently open. 

3. Click on the Left arrow to open the prior 
document that is currently open.  

4. Open Windows Explore to verify that only 
2 documents have been placed in the 
c:\Program Files\IBM\OnDemand32\Data 
directory. The name of the file will be 
similar to D4-11c.A32 

Screen D25 – Appendix D 

SRC CB00479  O Paid Items 
Report 301 

Up and Down  
buttons 

  1.     

SRC CB00480  A Paid Items 
Report 301 

Search and obtain 
more than 1 result 

  1.     

SRC CB00481  A Paid Items 
Report 301 

Open Report 1   1.     

SRC CB00482  A Paid Items 
Report 301 

Open Report 2   1.     

SRC CB00483  A Paid Items 
Report 301 

Up and Down  
buttons 

  1.     

3.5 Tool Bar Buttons 

TBB CB00484  S Open Folder Selection 1 N Verify Open 
Folder TBB is 
activated 

1. After the initial logon, click the Open 
Folder tool bar button. 

Screen D28 – Appendix D   

TBB CB00485  S Open Folder Selection 2 P Verify Open 
Folder TBB is 
activated 

1. After the initial logon, select ABC 
General Report View then click 
Open.  

2. Click the Open Folder tool bar button. 

Screen D29 – Appendix D   
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TBB CB00486  O Open Folder Selection 1 N Verify Open 
Folder TBB is 
activated 

1. After the initial logon, click the Open 
Folder tool bar button. 

Screen D28 – Appendix D   

TBB CB00487  O Open Folder Selection 2 P Verify Open 
Folder TBB is 
activated 

1. After the initial logon, select ABC 
General Report View then click 
Open. 

2. After the initial logon, click the Open 
Folder toolbar button. 

Screen D29 – Appendix D   

TBB CB00488  A Open Folder Selection 1 N Verify Open 
Folder TBB is 
activated 

1. After the initial logon, click the Open 
Folder toolbar button. 

Screen D28 – Appendix D   

TBB CB00489  A Open Folder Selection 2 P Verify Open 
Folder TBB is 
activated 

1. After the initial logon, select ABC 
General Report View then click 
Open. 

2. After the initial logon, click the Open 
Folder toolbar button. 

Screen D29 – Appendix D   

TBB CB00490  S Print Options screen P Verify Printer 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

Screen D30 – Appendix D 

Screen D31 – Appendix D 

  

TBB CB00491  S Print Select printer P Verify Select 
Printer option is 
activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

Screen D32 – Appendix D   
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3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the down arrow next to the 
setup button to select a printer. 

TBB CB00492  S Print Orientation (P/L) P Verify Printer 
Setup is 
available for 
page orientation 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the Setup button (or Page 
Setup, depending on your printer 
selection) to select the page 
orientation for print (portrait or 
landscape). 

Screen D32 – Appendix D   

TBB CB00493  S Print All pages P Verify Print All 
Pages is 
activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ All Pages to print the 

complete document 

Screen D31 – Appendix D   

TBB CB00494  S Print Current page P Verify Print 
Current Page 
is activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 

Screen D31 – Appendix D   
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t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Current Page to print the 

page being viewed. 

TBB CB00495  S Print Selected page/s P Verify Print 
Selected 
Pages is 
activated. 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Selected Pages to print 

the complete document. 

6. Print 5 pages from the document: 

• Page 1 

• Page 7 

• Page 12-14 

7. Click  ◙ From List, select 1, Click  

Add Pages 

8. Select 7, Click Add Pages 

9. Click ◙ By Range, enter 12 in From 

Page, enter 14 in To Page; Click Add 
Range. 

Screen D31 – Appendix D 

Screen D33 – Appendix D 

  

TBB CB00496  O Print Options screen P Verify Printer 1. Select the ABC Cheque Serial Screen D30 – Appendix D   
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TBB is activated Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

Screen D31 – Appendix D 

TBB CB00497  O Print Select printer P Verify Select 
Printer option is 
activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the down arrow next to the 
setup button to select a printer. 

Screen D32 – Appendix D   

TBB CB00498  O Print Orientation (P/L) P Verify Printer 
Setup is 
available for 
page orientation 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the Setup button (or Page 
Setup, depending on your printer 
selection) to select the page 
orientation for print (portrait or 
landscape). 

Screen D32 – Appendix D   

TBB CB00499  O Print All pages P Verify Print All 
Pages is 

1. Select the ABC Cheque Serial Screen D31 – Appendix D   
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activated Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ All Pages to print the 

complete document 

TBB CB00500  O Print Current page P Verify Print 
Current Page 
is activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Current Page to print the 

page being viewed. 

Screen D31 – Appendix D   

TBB CB00501  O Print Selected page/s P Verify Print 
Selected 
Pages is 
activated. 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Selected Pages to print 

the complete document. 

6. Print 5 pages from the document: 

Screen D31 – Appendix D 

Screen D33 – Appendix D 
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• Page 1 

• Page 7 

• Page 12-14 

7. Click  ◙ From List, select 1, Click  

Add Pages 

8. Select 7, Click Add Pages 

9. Click ◙ By Range, enter 12 in From 

Page, enter 14 in To Page; Click Add 
Range. 

TBB CB00502  A Print Options screen P Verify Printer 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

Screen D30 – Appendix D 

Screen D31 – Appendix D 

  

TBB CB00503  A Print Select printer P Verify Select 
Printer option is 
activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the down arrow next to the 
setup button to select a printer. 

Screen D32 – Appendix D   

TBB CB00504  A Print Orientation (P/L) P Verify Printer 
Setup is 
available for 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

Screen D32 – Appendix D   
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page orientation 2. Enter a Date range using the ABCbols  
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click the Setup button (or Page 
Setup, depending on your printer 
selection) to select the page 
orientation for print (portrait or 
landscape). 

TBB CB00505  A Print All pages P Verify Print All 
Pages is 
activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ All Pages to print the 

complete document 

Screen D31 – Appendix D   

TBB CB00506  A Print Current page P Verify Print 
Current Page 
is activated 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Current Page to print the 

page being viewed. 

Screen D31 – Appendix D   
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TBB CB00507  A Print Selected page/s P Verify Print 
Selected 
Pages is 
activated. 

1. Select the ABC Cheque Serial 
Number View; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Printer toolbar button 

5. Click on ◙ Selected Pages to print 

the complete document. 

6. Print 5 pages from the document: 

• Page 1 

• Page 7 

• Page 12-14 

7. Click  ◙ From List, select 1, Click  

Add Pages 

8. Select 7, Click Add Pages 

9. Click ◙ By Range, enter 12 in From 

Page, enter 14 in To Page; Click Add 
Range. 

Screen D31 – Appendix D 

Screen D33 – Appendix D 

  

TBB CB00508  S Zoom button 25% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  25%; press OK 

Screen D35 

Screen D34 
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TBB CB00509  S Zoom button 50% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click  ◙  50%; press OK 

Screen D35 

Screen D34 

  

TBB CB00510  S Zoom button 75% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  75%; press OK 

Screen D35 

Screen D34 

  

TBB CB00511  S Zoom button 100% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  100%; press OK 

Screen D35 

Screen D34 

  

TBB CB00512  S Zoom button 150% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 

Screen D35 

Screen D34 
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t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click  ◙  150%; press OK 

TBB CB00513  S Zoom button 200% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  200%; press OK 

Screen D35 

Screen D34 

  

TBB CB00514  S Zoom button 500% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙ 500%; press OK 

Screen D35 

Screen D34 

  

TBB CB00515  S Zoom button 1000% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

Screen D35 

Screen D34 
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4. Click the Zoom toolbar button 

5. Click ◙  1000%; press OK 

TBB CB00516  O Zoom button 25% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  25%; press OK 

Screen D35 

Screen D34 

  

TBB CB00517  O Zoom button 50% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  50%; press OK 

Screen D35 

Screen D34 

  

TBB CB00518  O Zoom button 75% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  75%; press OK 

Screen D35 

Screen D34 
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TBB CB00519  O Zoom button 100% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click  ◙  100%; press OK 

Screen D35 

Screen D34 

  

TBB CB00520  O Zoom button 150% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  150%; press OK 

Screen D35 

Screen D34 

  

TBB CB00521  O Zoom button 200% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  200%; press OK 

Screen D35 

Screen D34 

  

TBB CB00522  O Zoom button 500% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 

Screen D35 

Screen D34 
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t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  500%; press OK 

TBB CB00523  O Zoom button 1000% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  1000%; press OK 

Screen D35 

Screen D34 

  

TBB CB00524  A Zoom button 25% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  25%; press OK 

Screen D35 

Screen D34 

  

TBB CB00525  A Zoom button 50% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

Screen D35 

Screen D34 
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4. Click the Zoom toolbar button 

5. Click ◙  50%; press OK 

TBB CB00526  A Zoom button 75% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙   75%; press OK 

Screen D35 

Screen D34 

  

TBB CB00527  A Zoom button 100% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  100%; press OK 

Screen D35 

Screen D34 

  

TBB CB00528  A Zoom button 150% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  150%; press OK 

Screen D35 

Screen D34 
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TBB CB00529  A Zoom button 200% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  200%; press OK 

Screen D35 

Screen D34 

  

TBB CB00530  A Zoom button 500% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click ◙  500%; press OK 

Screen D35 

Screen D34 

  

TBB CB00531  A Zoom button 1000% P Verify Zoom 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the first document on the hit list. 

4. Click the Zoom toolbar button 

5. Click  ◙  1000%; press OK 

Screen D35 

Screen D34 

  

TBB CB00532  S Display a 
specific page 

Selection 1 P Verify Go To 
Page TBB is 
activated 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

Screen D36 

Screen D37 
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2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 
1708 document on the hit list. 

4. Click the GoTo Page toolbar button 

5. Select 3 then press OK. 

TBB CB00533  S Display a 
specific page 

Selection 2 P Verify Go To 
Page TBB is 
activated 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 
15377 document on the hit list. 

4. Click the GoTo Page toolbar button 

5. Select 6 then press OK. 

Screen D36 

Screen D37 

  

TBB CB00534  O Display a 
specific page 

Selection 1   1.     

TBB CB00535  O Display a 
specific page 

Selection 2   1.     

TBB CB00536  A Display a 
specific page 

Selection 1   1.     

TBB CB00537  A Display a 
specific page 

Selection 2   1.     

TBB CB00538  S Find first 
occurrence of 
a spec. text 
string 

Selection 1 P Verify Find 
TBB is 
activated 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 

Screen D38 

Screen D39 

Screen D40 
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t-1y through t. 

3. Open the report for CRS Account 
1708 document on the hit list. 

4. Click the Find Text String toolbar 
button 

5. Entert Paid Date then press Find. 

TBB CB00539  S Find first 
occurrence of 
a spec. text 
string 

Selection 2 P Verify Find 
TBB  is 
activated 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 
15377 document on the hit list.  

4. Click the Find Text String toolbar 
button 

5. Entert 0000002756 then press Find. 

Screen D38 

Screen D39 

Screen D40 

  

TBB CB00540  O Find a spec. 
text string 

Selection 1   1.     

TBB CB00541  O Find a spec. 
text string 

Selection 2   1.     

TBB CB00542  A Find a spec. 
text string 

Selection 1   1.     

TBB CB00543  A Find a spec. 
text string 

Selection 2   1.     

TBB CB00544  S Find prev. text 
string 

Selection 1 

(If not grayed out) 

 Verify Find 
Previous TBB 
is activated 

1. Click the Find Previous Text String 
toolbar button 

Screen D41 

Screen D40 
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TBB CB00545  S Find next text 
string 

Selection 1 

(If not grayed out) 

 Verify Find 
next TBB is 
activated 

1. Click the Find Next Text String 
toolbar button 

Screen D42 

Screen D40 

  

TBB CB00546  S Find prev. text 
string 

Selection 2 

(If not grayed out) 

 Verify Find 
Previous TBB 
is activated 

1. Click the Find Previous Text String 
toolbar button 

Screen D41 

Screen D40 

  

TBB CB00547  S Find next text 
string 

Selection 2 

(If not grayed out) 

 Verify Find 
next TBB is 
activated 

1. Click the Find Next Text String 
toolbar button 

Screen D42 

Screen D40 

  

TBB CB00548  S Find all 
occurrences 
of a text string 

Selection 1  Verify Find All 
works when 
activated with 
the Find TBB 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 
1708 document on the hit list. 

4. Click the Find Text String toolbar 
button 

5. Enter Paid Date then press Find All. 

6. Double-click on the Page 2, Line 27, 
line match. 

Screen D38 

Screen D39 

Screen D43 

  

TBB CB00549  S Find all 
occurrences 
of a text string 

Selection 2  Verify Find All 
works when 
activated with 
the Find TBB 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 

Screen D38 

Screen D39 

Screen D43 
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15377 document on the hit list.  

4. Click the Find Text String toolbar 
button 

5. Enter 0000002756 then press Find 
All. 

6. Double-click on the Page 6, Line 51, 
line match. 

TBB CB00550  S Display  Next Page  Verify Next 
Page TBB is 
activated 

1. Select the ABC External Accounts: 
Issued File Balancing View folder; 
press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t. 

3. Open the report for CRS Account 
15377 document on the hit list.  

4. Click on the Right Arrow in the Blue 
Book icon on the toolbar 

Screen D44   

TBB CB00551  S Display  Previous Page  Verify Previous 
Page TBB is 
activated 

1. Within the same document, click on 
the Left Arrow in the Blue Book icon 
on the toolbar 

Screen D45   

TBB CB00552  O Display  Previous Page   1.     

TBB CB00553  O Display  Next Page   1.     

TBB CB00554  A Display  Previous Page   1.     

TBB CB00555  A Display  Next Page   1.     

TBB CB00556  S View existing 
notes in the 
document 

Notes icon P Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 

Screen D47 

Screen D48 
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t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 
options. 

4. Press Search.  

5. Open the first document on the hit list. 

6. Click the Notes toolbar button 

TBB CB00557  S Add a new 
note 

Notes icon P Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 
options. 

4. Press Search.  

5. Open the first document on the hit list. 

6. Click the Notes toolbar button 

7. Select Add a Note; enter the text of 
the note; select Save. 

Screen D47 

Screen D48 

Screen D49 

  

TBB CB00558  O View existing 
notes in the 
document 

Notes icon P Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 

Screen D51   
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options. 

4. Press Search.  

5. Open the first document on the hit list. 

6. Click the Notes toolbar button 

TBB CB00559  O Add a new 
note 

Notes icon P Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 
options. 

4. Press Search.  

5. Open the first document on the hit list. 

6. Click the Notes toolbar button  

7. Select Add a Note; enter the text of 
the note; select Save. 

Screen D51   

TBB CB00560  A View existing 
notes in the 
document 

Notes icon P Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 
options. 

4. Press Search.  

5. Open the first document on the hit list. 

Screen D50 – Appendix D 

Only public notes displayed 
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6. Click the Notes toolbar button 

TBB CB00561  A Add a new 
note 

Notes icon N Verify Notes 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Void Items from the 
Report Description field drop-down 
options. 

4. Press Search.  

5. Open the first document on the hit list. 

6. Click the Notes toolbar button 

Screen D50 – Appendix D 

Add Note grayed out 

Only public notes displayed 

  

TBB CB00562  S View search 
criteria + doc 
list 

Folder search 
from within open 
document 

P Verify Folder 
Search Screen 
TBB is activated 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select 
the appropriate date range (e.g. 
“Between 01/01/01 and 01/01/02”) 

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. View CRS Account 8192. 

6.  While still viewing CRS Account 
8192, click on the Folder Search 
Screen icon. 

7. Select Dormant Account Report 
from the Report Description pull-

Screen D22 – Appendix D   
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down field. 

8. Press search  

9. Highlight the CRS Account 1287 
document; then press Enter to view 
the document.  

TBB CB00563  O View search 
criteria + doc 
list 

Folder search 
from within open 
document 

P Verify Folder 
Search Screen 
is activated 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

2. From the Folder Search Screen select 
the appropriate date range (e.g. 
“Between 01/01/01 and 01/01/02”) 

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. View CRS Account 8192. 

6.  While still viewing CRS Account 
8192, click on the Folder Search 
Screen icon. 

7. Select Dormant Account Report 
from the Report Description pull-
down field. 

8. Press search  

9. Highlight the CRS Account 1287 
document; then press Enter to view 
the document. 

Screen D22 – Appendix D   

TBB CB00564  A View search 
criteria + doc 

Folder search 
from within open 

P Verify Folder 
Search Screen 

1. Select ABC Reports – Cheque Serial 
Number View and press Open. 

Screen D22 – Appendix D   
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list document TBB is activated 2. From the Folder Search Screen select 
the appropriate date range (e.g. 
“Between 01/01/01 and 01/01/02”) 

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. View CRS Account 8192. 

6.  While still viewing CRS Account 
8192, click on the Folder Search 
Screen icon. 

7. Select Dormant Account Report 
from the Report Description pull-
down field. 

8. Press search  

9. Highlight the CRS Account 1287 
document; then press Enter to view 
the document. 

TBB CB00565  S View previous 
open doc. 

 P Verify View 
Previous Open 
Document is 
activated. 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. Highlight all 3 items for the Nova 

Screen D27 – Appendix D   
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company. 

6. Select View All Selected. 

7. While viewing one of the selected 
documents click on the Left arrow to 
open the prior document that is 
currently open. 

TBB CB00566  O View previous 
open doc. 

 P Verify View 
Previous Open 
Document is 
activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. Highlight all 3 items for the Nova 
company. 

6. Select View All Selected. 

7. While viewing one of the selected 
documents click on the Left arrow to 
open the prior document that is 
currently open. 

Screen D27 – Appendix D   

TBB CB00567  A View previous 
open doc. 

 P Verify View 
Previous Open 
Document is 
activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 

Screen D27 – Appendix D   
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field drop-down options. 

4. Press Search. 

5. Highlight all 3 items for the Nova 
company. 

6. Select View All Selected. 

7. While viewing one of the selected 
documents click on the Left arrow to 
open the prior document that is 
currently open. 

TBB CB00568  S View next 
previously 
opened doc. 

 P Verify View 
Next Open 
Document is 
activated 

1. While viewing one of the selected 
documents click on the Right arrow to 
open the next document that is 
currently open.  

Screen D26 – Appendix D   

TBB CB00569  O View next 
previously 
opened doc. 

 P Verify View 
Next Open 
Document is 
activated 

1. While viewing one of the selected 
documents click on the Right arrow to 
open the next document that is 
currently open. 

Screen D26 – Appendix D   

TBB CB00570  A View next 
previously 
opened doc. 

 P Verify View 
Next Open 
Document is 
activated 

1. While viewing one of the selected 
documents click on the Right arrow to 
open the next document that is 
currently open. 

Screen D26 – Appendix D   

TBB CB00571  S View Next 
item in doc list 

 P Verify the View 
Next Item on 
Hit List is 
activated. 

1. From within an open document, close 
the current document and open the 
next document on the hit list. 

2.  Click on the Down arrow to open the 
next document from the hit list. 

Screen D20 – Appendix D   

TBB CB00572  O View 
Previous 

 P Verify the View 
Previous Item 

1. From within an open document, close 
the current document and open the 

Screen D21 – Appendix D   
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item in doc list on Hit List is 
activated. 

previous document on the hit list. 

2. Click on the Up arrow to open the 
previous document listed on the hit 
list. 

TBB CB00573  A View 
Previous 
item in doc list 

 P Verify the View 
Previous Item 
on Hit List is 
activated. 

1. From within an open document, close 
the current document and open the 
previous document on the hit list. 

2. Click on the Up arrow to open the 
previous document listed on the hit 
list. 

Screen D21 – Appendix D   

TBB CB00574  S Use the Help 
(?) option 

 P Verify the Help 
TBB is activated 

1. From within an open document, click 
on the Help icon (angled arrow and 

?). The cursor transforms into ↑? 

2. Move the ↑? on top of the Folder 

Search Criteria toolbar; click the left 
mouse button. 

Screens D52, D53, D54 – 
Appendix D 

  

TBB CB00575  O Use the Help 
(?) option 

 P Verify the Help 
TBB is activated 

1. From within an open document, click 
on the Help icon (angled arrow and 

?). The cursor transforms into ↑? 

2. Move the ↑? on top of the Folder 

Search Criteria toolbar; click the left 
mouse button. 

Screens D52, D53, D54 – 
Appendix D 

  

TBB CB00576  A Use the Help 
(?) option 

 P Verify the Help 
TBB is activated 

1. From within an open document, click 
on the Help icon (angled arrow and 

?). The cursor transforms into ↑? 

2. Move the ↑? on top of the Folder 

Search Criteria toolbar; click the left 

Screens D52, D53, D54 – 
Appendix D 
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mouse button. 

TBB CB00577  S Short cut 10: 
Find total 

 P Verify the Find 
Total Shortcut 
is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Report 3 Maintenance from 
the Report Description field drop-
down options. 

4. Press Search. 

5. View the item for the Wirtz Group 
Personnel company. 

6. Click on the Shortcut #10 icon 

7.  

Screens D55, D56, Appendix D   

TBB CB00578  O Short cut 10: 
Find total 

 P Verify the Find 
Total Shortcut 
is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the Shortcut #10 icon 

7. Click on Find Next text icon to move 

Screens D55, D56, D42  
Appendix D 
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to the next Total text match 

TBB CB00579  A Short cut 10: 
Find total 

 P Verify the Find 
Total Shortcut 
is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. View the item for the Andarko 
Canada Corp company. 

6. Click on the Shortcut #10 icon 

Screens D55, D56, Appendix D   

TBB CB00580  S View related 
Report 3 

 P Verify Related 
Documents 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD1 TBB 

Screens D57, D62 – Appendix D   

TBB CB00581  S View related 
Report 301 

 P Verify Related 
Documents 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 

Screens D58, D62 – Appendix D   
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t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD2 TBB 

TBB CB00582  S View related 
Report 302 

 P Verify Related 
Documents 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD3 TBB 

Screens D59, D62 – Appendix D   

TBB CB00583  S View related 
Report 303 

 P Verify Related 
Documents 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

Screens D60, D62 – Appendix D   
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4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD4 TBB 

TBB CB00584  S View related 
Report 306 

 P Verify Related 
Documents 
TBB is activated 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD5 TBB 

Screens D61, D62 – Appendix D   

TBB CB00585  O View related 
Report 3 

 N Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

Screens D57, D62 – Appendix D   
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6. Click on the RD1 TBB 

TBB CB00586  O View related 
Report 301 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Stop Payment from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

6. Click on the RD2 TBB. 

7. Close the related document by 

clicking on the  on the upper right 

window of the 301 document.  

Screens D58, D64 – Appendix D   

TBB CB00587  O View related 
Report 302 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Rpt 4 – Duplicate Serial 
Number from the Report Description 
field drop-down options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

6. Click on the RD3 TBB. 

Screens D59, D65 – Appendix D   
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7. Close the related document by 

clicking on the  on the upper right 

window of the 302 document. 

TBB CB00588  O View related 
Report 303 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

6. Click on the RD4 TBB.  

7. Close the related document by 

clicking on the  on the upper right 

window of the 303 document. 

Screens D60, D63 – Appendix D   

TBB CB00589  O View related 
Report 306 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Stop Payment from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the item for the Branch 

Screens D61, D66 – Appendix D   
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Remittances company. 

6. Click on the RD5 TBB. 

7. Close the related document by 

clicking on the  on the upper right 

window of the 301 document. 

TBB CB00590  A View related 
Report 3 

 N Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Dormant Account Report 
from the Report Description field 
drop-down options. 

4. Press Search. 

5. View the item for the PMO English 
Dormant company. 

6. Click on the RD1 TBB 

Screens D57, D62 – Appendix D   

TBB CB00591  A View related 
Report 301 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Stop Payment from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

Screens D58, D64 – Appendix D   
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6. Click on the RD2 TBB. 

7. Close the related document by 

clicking on the  on the upper right 

window of the 301 document. 

TBB CB00592  A View related 
Report 302 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select Rpt 4 – Duplicate Serial 
Number from the Report Description 
field drop-down options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

6. Click on the RD3 TBB. 

7. Close the related document by 

clicking on the  on the upper right 

window of the 302 document. 

Screens D59, D65 – Appendix D   

TBB CB00593  A View related 
Report 303 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select FRS Daily Report: Online 
Issues from the Report Description 
field drop-down options. 

4. Press Search. 

Screens D60, D63 – Appendix D   
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5. View the item for the Branch 
Remittances company. 

6. Click on the RD4 TBB.  

7. Close the related document by 

clicking on the  on the upper right 

window of the 303 document. 

TBB CB00594  A View related 
Report 306 

 P Verify a related 
document is 
viewable 

1. Select the ABC Cheque Serial 
Number View folder; press Enter. 

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 304 Stop Payment from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

6. Click on the RD5 TBB. 

7. Close the related document by 

clicking on the  on the upper right 

window of the 301 document. 

Screens D61, D66 – Appendix D   
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3.6 Menu Bar Buttons 

3.6.1 Disallowed Functions 

3.6.1.1 Paid Items Report 301 

MBB CB00595   File Save Named 
Query 

 Verify user is 
unable to create 
a named query 

1. Select the ABC – Cheque Serial  
Number View folder; press Enter. 

2. Click on the File dropdown menu. 

Screen D67 – Appendix D   

MBB CB00596   File Select Named 
Query 

 Verify user is 
unable to 
access a 
named query 

1. Select the ABC – Cheque Serial 
Number View folder; press Enter. 

2. Click on the File dropdown menu. 

Screen D67 – Appendix D   

MBB CB00597   File Delete Named 
Query 

 Verify a user is 
unable to delete 
a named query 

1. Select the ABC – Cheque Serial  
Number View folder; press Enter. 

2. Click on the File dropdown menu. 

Screen D67 – Appendix D   

MBB CB00598   View Select View  Verify a user 
has access to 
Select aView 

1. Select the ABC Cheque Serial 
Number View folder; press Enter.  

2. Enter a Date range using the ABCbols 
t-1y through t.  

3. Select 301 Paid Items from the 
Report Description field drop-down 
options. 

4. Press Search. 

5. View the item for the Branch 
Remittances company. 

Enabled only if expression find 
enabled 

Screens D68, D69 – Appendix D 

  



SOPs for OnDemand 

Archive Project - SOPs for OnDemand – CRS Dept. , (Draft 5)  247 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

6. Click on the View dropdown menu 

7. Select Select View 

MBB CB00599   View Reset View  Verify a user 
has access to 
Select a View 

1. While viewing the 301 Paid 
Exceptions report for the Branch 
Remittances company, click on the 
View dropdown menu. 

Screen D68 – Appendix D   

MBB CB00600   View Save View  Verify a user 
has access to 
Create and 
Save a View 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the View dropdown 
menu. 

Screen D68 – Appendix D   

MBB CB00601   View Set Default View  Verify a user 
has access to 
Set a Defaultt a 
View 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the View dropdown 
menu. 

Screen D68 – Appendix D   

MBB CB00602   View Delete View  Verify a user 
has access to 
Delete a View 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the View dropdown 
menu. 

Screen D68 – Appendix D   

MBB CB00603   Edit  Copy Text from 
Document 

 Verify a user 
cannot copy 
text 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the Edit dropdown 
menu. 

Must select text in open report to 
ensure this is disabled 

Screen D70 – Appendix D 

  

MBB CB00604   Edit Copy Bitmap from 
Document 

 Verify a user 
cannot copy 
graphics 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the Edit dropdown 
menu. 

Must select text in open report to 
ensure this is disabled 

Screen D70 – Appendix D 

  

MBB CB00605   Edit Copy Document 
pages to File 

 Verify a user 
cannot copy a 

1. While viewing the 301 Paid Items 
report for the Branch Remittances 
company, click on the Edit dropdown 

Screen D70 – Appendix D   
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document menu. 

3.6.1.2 Paid Exceptions Report 302 

MBB CB00606   File Save Named 
Query 

  1.     

MBB CB00607   File Select Named 
Query 

  1.     

MBB CB00608   File Delete Named 
Query 

  1.     

MBB CB00609   View Select View   1.  Enabled only if expression find 
enabled 

  

MBB CB00610   View Reset View   1.     

MBB CB00611   View Save View   1.     

MBB CB00612   View Set Default View   1.     

MBB CB00613   View Delete View   1.     

MBB CB00614   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00615   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00616   Edit Copy Document 
pages to File 

  1.     

3.6.1.3 Paid No Issue Report 303 

MBB CB00617   File Save Named 
Query 

  1.     
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MBB CB00618   File Select Named 
Query 

  1.     

MBB CB00619   File Delete Named 
Query 

  1.     

MBB CB00620   View Select View   1.  Enabled only if expression find 
enabled 

  

MBB CB00621   View Reset View   1.     

MBB CB00622   View Save View   1.     

MBB CB00623   View Set Default View   1.     

MBB CB00624   View Delete View   1.     

MBB CB00625   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00626   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00627   Edit Copy Document 
pages to File 
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3.6.1.4 Stop Payment Report 304 

MBB CB00628   File Save Named 
Query 

  1.     

MBB CB00629   File Select Named 
Query 

  1.     

MBB CB00630   File Delete Named 
Query 

  1.     

MBB CB00631   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00632   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00633   Edit Copy Document 
pages to File 

      

3.6.1.5 Cancelled Items Report 304 

MBB CB00634   File Save Named 
Query 

  1.     

MBB CB00635   File Select Named 
Query 

  1.     

MBB CB00636   File Delete Named 
Query 

  1.     

MBB CB00637   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00638   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00639   Edit Copy Document       



SOPs for OnDemand 

Archive Project - SOPs for OnDemand – CRS Dept. , (Draft 5)  251 

G
ro

u
p

in
g

 

S
O

P
 N

o
. 

A
cc

es
s 

L
ev

el
 

Name of the SOP  Purpose of 
the SOP 

Instructions/Procedures (steps to follow, 
data to obtain, etc.) 

Expected Result 

A
ct

u
al

 T
es

t 
R

es
u

lt
 

(F
=

F
ai

l S
=

S
u

cc
es

s)
 

Remarks 

pages to File 

3.6.1.6 Void Items Report 304 

MBB CB00640   File Save Named 
Query 

  1.     

MBB CB00641   File Select Named 
Query 

  1.     

MBB CB00642   File Delete Named 
Query 

  1.     

MBB CB00643   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00644   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00645   Edit Copy Document 
pages to File 

      

3.6.1.7 Outstanding Issues Report 305 

MBB CB00646   File Save Named 
Query 

  1.     

MBB CB00647   File Select Named 
Query 

  1.     

MBB CB00648   File Delete Named 
Query 

  1.     

MBB CB00649   View Select View   1.  Enabled only if expression find 
enabled 

  

MBB CB00650   View Reset View   1.     
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MBB CB00651   View Save View   1.     

MBB CB00652   View Set Default View   1.     

MBB CB00653   View Delete View   1.     

MBB CB00654   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00655   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00656   Edit Copy Document 
pages to File 

      

3.6.1.8 Trace List Report 306 

MBB CB00657   File Save Named 
Query 

  1.     

MBB CB00658   File Select Named 
Query 

  1.     

MBB CB00659   File Delete Named 
Query 

  1.     

MBB CB00660   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00661   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00662   Edit Copy Document 
pages to File 
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3.6.1.9 Input Journal Summary Report 1 

MBB CB00663   File Save Named 
Query 

  1.     

MBB CB00664   File Select Named 
Query 

  1.     

MBB CB00665   File Delete Named 
Query 

  1.     

MBB CB00666   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00667   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00668   Edit Copy Document 
pages to File 

      

3.6.1.10 Company wide Input Journal Summary Report 1 

MBB CB00669   File Save Named 
Query 

  1.     

MBB CB00670   File Select Named 
Query 

  1.     

MBB CB00671   File Delete Named 
Query 

  1.     

MBB CB00672   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00673   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00674   Edit Copy Document       
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pages to File 

3.6.1.11 Input Journal Reject Report 2 

MBB CB00675   File Save Named 
Query 

  1.     

MBB CB00676   File Select Named 
Query 

  1.     

MBB CB00677   File Delete Named 
Query 

  1.     

MBB CB00678   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00679   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00680   Edit Copy Document 
pages to File 

      

3.6.1.12 Company wide Input Journal Reject Report 2 

MBB CB00681   File Save Named 
Query 

  1.     

MBB CB00682   File Select Named 
Query 

  1.     

MBB CB00683   File Delete Named 
Query 

  1.     

MBB CB00684   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00685   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 
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MBB CB00686   Edit Copy Document 
pages to File 

      

3.6.1.13 File Maintenance Register Report 3 

MBB CB00687   File Save Named 
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MBB CB00688   File Select Named 
Query 

  1.     

MBB CB00689   File Delete Named 
Query 

  1.     

MBB CB00690   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00691   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00692   Edit Copy Document 
pages to File 

      

3.6.1.14 Company wide Maintenance Report 3 

MBB CB00693   File Save Named 
Query 
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MBB CB00694   File Select Named 
Query 
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MBB CB00695   File Delete Named 
Query 
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MBB CB00696   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00697   Edit Copy Bitmap from   1.  Must select text in open report to   
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MBB CB00698   Edit Copy Document 
pages to File 

      

3.6.1.15 Duplicate Serial Number Report 4 

MBB CB00699   File Save Named 
Query 
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MBB CB00700   File Select Named 
Query 

  1.     

MBB CB00701   File Delete Named 
Query 

  1.     

MBB CB00702   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00703   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00704   Edit Copy Document 
pages to File 

      

3.6.1.16 Purged Transactions Report 6 

MBB CB00705   File Save Named 
Query 

  1.     

MBB CB00706   File Select Named 
Query 

  1.     

MBB CB00707   File Delete Named 
Query 

  1.     

MBB CB00708   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 
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MBB CB00709   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00710   Edit Copy Document 
pages to File 

      

3.6.1.17 FRS Daily Report : Account Balance Report 7 

MBB CB00711   File Save Named 
Query 
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MBB CB00712   File Select Named 
Query 

  1.     

MBB CB00713   File Delete Named 
Query 

  1.     

MBB CB00714   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00715   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00716   Edit Copy Document 
pages to File 

      

3.6.1.18 Account Balance Report 8 

MBB CB00717   File Save Named 
Query 
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MBB CB00718   File Select Named 
Query 

  1.     

MBB CB00719   File Delete Named 
Query 
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MBB CB00720   Edit  Copy Text from   1.  Must select text in open report to   
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MBB CB00721   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00722   Edit Copy Document 
pages to File 

      

3.6.1.19 Reversal Register Report 11 

MBB CB00723   File Save Named 
Query 

  1.     

MBB CB00724   File Select Named 
Query 

  1.     

MBB CB00725   File Delete Named 
Query 

  1.     

MBB CB00726   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00727   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00728   Edit Copy Document 
pages to File 
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3.6.1.20 Company wide Paid Exception Report [999] 

MBB CB00729   File Save Named 
Query 
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MBB CB00730   File Select Named 
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MBB CB00731   File Delete Named 
Query 
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MBB CB00732   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00733   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00734   Edit Copy Document 
pages to File 

      

3.6.1.21 FRS Daily Report : Online Cancel Report [994] 

MBB CB00735   File Save Named 
Query 
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MBB CB00736   File Select Named 
Query 

  1.     

MBB CB00737   File Delete Named 
Query 

  1.     

MBB CB00738   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00739   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00740   Edit Copy Document       
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3.6.1.22 FRS Daily Report: Online Issues Report [993] 

MBB CB00741   File Save Named 
Query 

  1.     

MBB CB00742   File Select Named 
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MBB CB00744   Edit  Copy Text from 
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  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00745   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00746   Edit Copy Document 
pages to File 

      

3.6.1.23 List of Drafts for CRS Reimbursements Report [991] 

MBB CB00747   File Save Named 
Query 
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MBB CB00748   File Select Named 
Query 

  1.     

MBB CB00749   File Delete Named 
Query 

  1.     

MBB CB00750   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00751   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 
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MBB CB00752   Edit Copy Document 
pages to File 

      

3.6.1.24 List of Drafts for CRS Replacements Report [990] 

MBB CB00753   File Save Named 
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MBB CB00758   Edit Copy Document 
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3.6.1.25 Company wide Paid No Issue Report [998] 

MBB CB00759   File Save Named 
Query 
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Query 
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MBB CB00761   File Delete Named 
Query 

  1.     

MBB CB00762   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00763   Edit Copy Bitmap from   1.  Must select text in open report to   
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MBB CB00764   Edit Copy Document 
pages to File 

      

3.6.1.26 FRS Daily Lodge: Daily Lodge/Remove Stop Summary Report [996] 

MBB CB00765   File Save Named 
Query 
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MBB CB00766   File Select Named 
Query 
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MBB CB00767   File Delete Named 
Query 
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MBB CB00768   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00769   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00770   Edit Copy Document 
pages to File 

      

3.6.1.27 FRS Daily Report : Daily Lodge Stop Report [997] 

MBB CB00771   File Save Named 
Query 

  1.     

MBB CB00772   File Select Named 
Query 

  1.     

MBB CB00773   File Delete Named 
Query 

  1.     

MBB CB00774   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 
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MBB CB00775   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00776   Edit Copy Document 
pages to File 

      

3.6.1.28 FRS Daily Report : Paid Against Stop Report [995] 

MBB CB00777   File Save Named 
Query 

  1.     

MBB CB00778   File Select Named 
Query 

  1.     

MBB CB00779   File Delete Named 
Query 

  1.     

MBB CB00780   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00781   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00782   Edit Copy Document 
pages to File 

      

3.6.1.29 CRS Account Summary Report 490 

MBB CB00783   File Save Named 
Query 
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MBB CB00784   File Select Named 
Query 

  1.     

MBB CB00785   File Delete Named 
Query 

  1.     

MBB CB00786   Edit  Copy Text from   1.  Must select text in open report to   
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MBB CB00787   Edit Copy Bitmap from 
Document 
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ensure this is disabled 

  

MBB CB00788   Edit Copy Document 
pages to File 

      

3.6.1.30 Dormant Account Report [992] 

MBB CB00789   File Save Named 
Query 
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Query 
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MBB CB00792   Edit  Copy Text from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00793   Edit Copy Bitmap from 
Document 

  1.  Must select text in open report to 
ensure this is disabled 

  

MBB CB00794   Edit Copy Document 
pages to File 
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4. List of Results of all SOPs 

Test Case 
No. 

Name of Test Case Date Tested Who Tested Result (S=Success 
F=Failure) 

Remarks 

SEC-001 Logging in to OnDemand     
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5. List of Failures and Actions taken to Resolve 

 

Test 
Case 
No. 

Test Case Name Description of Failure Action Taken By Whom Remarks 
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1. Introduction 

This section outlines the purpose and scope of the Appendix A - Screen Images for SOPs in OnDemand  

for the Archive Project. 

1.1 Purpose 

The purpose of this document is to provide screen images of SOPs (section 3.1) and are described in the 

main document SOPs for OnDemand project. 
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2. Appendix A – Screen shots from SOPs – Section 3.1 

Screen No. Brief Description Screen Image 

A1  Access the 

OnDemand 

application 

 

A2  Log on to the 

system 

 

A3  Key in your User 

ID and password 

 

 

A4  Unexpected Result 
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A5  Expected Result 

 

A6  Access to all folders 

you are authorized 

to access 

 

 

 

A7  Access to all 

reports in the 

Cheque Serial 

Number Folder 
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A8  Access to all 

reports in the 

Internal Accounts 

Balancing Folder 

 

A9  Select Report 301 – 

Paid Items 

 

A10  Select Report 303 – 

Paid No Issue 

 

A11  Select Report 304 – 

Stop Payment 
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A12  Select Report 305 – 

Outstanding Issues 

 

A13  Select Report 3 – 

Maintenance 

Report 

 

A14  Select Rpt 007 FRS 

Daily: Account 

Balance 

 

A15  Adding text notes 

in the opened 

report 
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A16  Adding lines, 

arrows, stamps and 

any graphical 

annotations in a 

report 

 

A17  Viewing Notes 

 

A18  Deleting Notes 
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A19  Updating Notes in 

the report 

 

A20  Updating the 

graphical 

annotation 
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A21  Copying Notes 

 

A22  Printing Notes 
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A23  Sorting Notes: 

− Ascending 

− Descending, or 

− Creating Date and 

Time 

− Page Number 

− User ID 

 

A24  View User’s ID 

who made 

graphical 

annotation in the 

report – Step 1 
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A25  View User’s ID 

who made 

graphical 

annotation in the 

report – Step 2 

 

A26  

Select Report 302 – 

Paid Exceptions 
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A27  

Select Report 306 – 

Trace List 

 

A28  

Select Reversal 

Register Report 8 

 

A29   
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